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About the Lightroom 1.1 update supplement
As an Adobe alpha tester and author I have had the unique experience 
of being involved with Lightroom from the start. As well as writing about 
the program, I have for several years now been closely involved with the 
engineers who work on Lightroom. Yet even I was taken aback when I got 
my first glimpse of what they had planned for Lightroom 1.1. With Adobe 
Photoshop, a dot release of the program would usually be nothing more 
than a maintenance update. But the Lightroom team sure like to do things 
differently! With over 100 improvements planned for Lightroom 1.1, it soon 
became apparent that this was going to be no ordinary update. Obviously 
this has been good news for Lightroom customers who can now upgrade 
to Lightroom 1.1 for free. But if Lightrooom customers were going to get 
a major update for Lightroom, then it seemed logical enough that I should 
do the same thing for the readers who had bought my book.

The solution I came up with was to write a supplement for the existing 
print book in the form of a PDF document, which is what you are reading 
now. This PDF uses the same format as the original book and is print 
enabled so you can print it out should you wish. There is also a table of 
contents at the beginning and an Index at the back – these should make it 
easier for you to navigate the content.

Because I have used the same layout design as the print book, you will note 
that the page numbering picks up from where The Adobe Photoshop 
Lightroom Book ended, which is why the beginning chapter starts at 
page 353. I did this not to confuse readers who will want to refer to the 
published book. Where I discuss a topic that is also covered in the original 
book, you can use the page references in the margins to cross-reference 
the print book. To get the most benefit from this update, you should 
have the printed book. if you don’t, you can still get value from this PDF, 
but I hope it will inspire to buy the book for a more complete picture of 
Lightroom. I have taken care to use the same clear layout plan as was 
used in the book and make the information provided in this PDF as easy 
to access as possible. While I am sure there may be a few items I may 
have missed, I think you will find that the content presented here is just as 
comprehensive as the original book.

To view this PDF supplement as it was intended to be read, I suggest you 
set the page view settings of your PDF viewer program to a two-up display. 
If you prefer, you can make a print copy, there are no printing restrictions, 
but there are restrictions that will prevent copying or editing of the content.

inTroduC Tion
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About the book

The Adobe Photoshop Lightroom Book by Martin Evening is available 
from Peachpit, Amazon, Barnes & Noble and all usual bookstore outlets. 
The book is primarily aimed at photographers who wish to learn about 
Lightroom at an intermediate to advanced level and is written with 
photographers in mind. The Adobe Photoshop Lightroom Book describes 
all of Lightroom’s features in detail and has a clear well-designed layout, 
making it easy for the reader to access and digest various topics about 
Lightroom. The book does not shy away from giving you the low down on 
the more advanced aspects of the program and it contains lots of unique 
tips and advice on how to process your photographs. Photographers who 
routinely work with raw (and even JPEG & TIFF) images will find Lightroom 
and The Adobe Photoshop Lightroom Book an indispensable tool in 
their digital darkroom.

Acknowledgments

The turnaround time for this PDF supplement has had to be quite swift. 
I would like to thank Rod Wynne-Powell for providing his technical proof 
editing services once again. Thank you to Jeff Schewe for his help advice on 
how to get the content published on Lightroom-news.com (where you can 
leave comments if you wish) and Pam Pfiffner at Peachpit for her help with 
the PDF publishing and proofreading.
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General menu items1

With the release of the 1.1 update, the Lightroom program has 

undergone a number of fundamental changes. The program’s 

performance has been tuned to run that little bit faster and 

more smoothly and the Optimize option can also help improve 

Lightroom’s efficiency. Elsewhere you will notice quite a 

number of interface changes, not least in the Lightroom menus. 

When you first launch Lightroom after upgrading you will 

see a big change here, so as a service to those of you who are 

upgrading I have highlighted all the main menu differences. 

You can use this as a quick guide to some of the new changes. 

Let’s start by looking at the File, Edit and Help menus, which 

are common to all of the Lightroom modules (I have not 

included the Window menu here because this is the one menu 

list that hasn’t changed in 1.1).
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File Menu

Catalog options
Starting from the top, we have the Catalog options. Catalog is the 
new term now used to describe what used to be referred to as the 
Lightroom Image Library (the file that contains all the information used 
to manage the images that are displayed in Lightroom). This change 
in terminology from ‘Library’ to ‘Catalog’ now provides a clearer 
distinction between it and the Library module. Plus there is now better 
support for multiple catalogs.

The top three items in the File menu allow you to create a new catalog 
(New Catalog…), open an existing catalog (Open Catalog…), or 
choose: Open Recent and select a recently opened catalog from 
the fly-out menu. Note that whenever you choose to create a new 
catalog or you choose to load an existing catalog, you have to restart 
Lightroom after you do so in order to launch the program using the 
new catalog. This is because in Lightroom 1.1 you can only open a 
single catalog at a time – you won’t be able to open several catalogs at 
once just yet.

Exporting catalogs
A lot of people may find they will be fine using just the one catalog 
for all their images. But let’s say you are sharing a computer running 
Lightroom with other people; each user can maintain their own sepa-
rate catalog to reference and manage the images they are interested in 
working with.

Figure 1.1 The File menu, which is common to all Lightroom 1.1 modules.

page references
lightroom database 308–311
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It is more likely that photographers will want to use this feature to 
export images from one copy of Lightroom and then import this 
catalog to another computer running Lightroom. To do this, you would 
make a selection of photographs via the Library module or the Filmstrip 
and choose: Export as Catalog…, which will open the dialog shown 
below in Figure 1.2, where you can choose the location to save a 
catalog to. A catalog export will at a minimum always export the 
ratings and other metadata information. But if you want to export 
more than just this basic information, you will want to check the 
Export negative files and Include available previews options. 
Note that you can only export to create new catalogs. You can’t export 
and add to an existing catalog folder.

Figure 1.2 The Export as Catalog dialog will appear whenever you select photos 
to export. This includes the option to export the selected photographs only, or all the 
photos in the current library grid/filmstrip view. 

Exporting with negatives

If you export a catalog with ‘Export negative files’ checked, this will 
export a copy of the current catalog contents that includes all the 
master photos. These will be the raw files, JPEGs, TIFFs or PSD image 
files that are in the catalog. When this option is checked Lightroom 
will export all of the catalog information along with the original master 
files. Including the negatives will allow you to copy single folders or an 
entire catalog from one computer to another with ease. Of course, if 
you are exporting the master ‘negatives’ as you export a catalog, the 
export process slows down by quite a bit and you will see a progress 
bar indicator in the top panel of the Library window (see Figure 
1.3). I should also point out that you will need to have at least 200 
MB of free disk space on your computer that Lightroom will use as a 
temporary directory when creating a new exported catalog.

Figure 1.3 Exporting catalog in 
progress.

note
With lightroom 1.1, the develop 

snapshots will now also get stored in 

the XmP metadata. this means that 

you can now export the snapshots 

associated with the photos when you 

carry out an export.
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Exporting without negatives

If you deselect the ‘Export negative files’ option, you can export a cata-
log from your main computer that is lightweight enough to run from a 
laptop computer without occupying much disk space. The advantage 
of this is that you can export a large catalog relatively quickly, use it to 
markup ratings and add keywords etc. The downside is that there are 
some limitations as to what you can do in Lightroom when working 
with a catalog that is missing the master negatives.

Including available previews

If Include available previews is checked, Lightroom will include 
all the Library grid thumbnails, standard resolution loupe views (in 
whatever form they are rendered) and 1:1 rendered views (if available) 
as part of the export. If you refer to the appendix section of the 
printed book (see sidebar page references) you can read in detail about 
how Lightroom goes through several stages of preview rendering. At a 
minimum, Lightroom will have thumbnail and standard size previews of 
each photo in the catalog. How detailed the previews are will depend 
on whether Lightroom has had a chance to render them fully or not. 
You should always see good quality thumbnails, but if Lightroom has 
not had a chance to render proper standard size previews (at the pixel 
size you have set in the preferences), then the standard size/full screen 
loupe view previews will sometimes look pixelated because they are 
nothing more than enlarged thumbnail previews.

The include available previews option is more critical if you are export-
ing a catalog without including the master negatives. This is because 
once a catalog has been exported without the original negatives you 
won’t be able to re-render the previews. Selecting ‘Include available 
previews’ will include the previews in whatever state they are in. So 
you may therefore want to consider going to the Library menu in 
the Library module and running ‘Render Standard-Sized Previews‘ 
before exporting a catalog. And if you want to include full resolution 
previews, then you might want to consider running the ‘Render 1:1’ 
Previews routine.

But there are good reasons not to include previews. If you need to 
export a catalog that contains just the metadata edits so that you sync 
these up with a master catalog, then deselecting ‘Include available 
previews’ will save carrying out this unnecessary step and make the 
export process a lot quicker.

page references
lightroom previews data        311 

thumbnail processing       312–314
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Figure 1.5 Import from Catalog dialog.

If you check both this and the ‘Export negative files’ and ‘Include 
available previews’ options, you will then end up with an exported 
catalog that looks like the folder shown in Figure 1.4, where the 
catalog folder contains an .lrcat catalog file, a Previews.lrdata file 
that contains the thumbnails and preview image data and a sub folder 
that contains the master ‘negatives’.

Figure 1.4 This shows a folder view of an exported catalog along with the Images 
folder and previews file.

Importing catalogs
Now let’s imagine you have transferred the exported catalog to 
another computer. You can then go to the Import from Catalog… 
menu item, select the exported .lrcat file and open it. You will then 
see the Import from Catalog dialog shown in Figure 1.5, where you 
can choose to import the images by copying them to a new location 
and add them to a current Lightroom catalog. Alternatively, you can 
choose to import the files by referencing them in their present location.
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A catalog export and import in action

1. Over the next few steps I am going to show you how to use the 
Catalog export and import feature to copy a Lightroom catalog 
from a main computer over to a laptop computer. Here is the com-
puter that holds the master catalog collection of photos, where all 
the master images are stored on the internal drive.

2. My objective here was to export the entire Lightroom catalog to a 
removable hard drive so that I could then access it via a secondary 
computer. To do this, I highlighted All Photographs in the Library 
panel (to select all the catalog contents), then went to the File 
menu and chose Export as Catalog... I wanted to export the 
complete catalog so I deselected the ‘Export Selected photos only’ 
option. And because I wanted to export a lightweight version of 
the catalog, I deselected the ‘Export negative files’ option. But I 
did keep the ‘Include available previews’ option checked, because I 
wanted to preserve these wherever possible.
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3. After I had exported the master catalog, I disconnected the 
removable drive from the iMac computer and reconnected it to the 
laptop. On the laptop computer I opened Lightroom, chose: File ➯ 
Open Catalog..., used the navigation dialog shown here to locate 
the exported catalog file on the removable hard drive and clicked 
Open. This opened the warning dialog, also shown here, where 
I had to click on the Relaunch button to restart Lightroom with 
Lightroom running from the new catalog.

4. After the new catalog had opened I was able to access the 
exported iMac catalog via the laptop. Now in this instance, I was 
accessing the catalog from the removable drive. But I could just 
as easily copied the catalog to the laptop drive and opened the 
catalog from there.
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5. If you export a catalog without including the negatives (the master 
photos), there is only so much that you can do with it. I’ll list 
shortly what you can and can’t do exactly, but basically you will 
still be able to navigate the catalog and edit the metadata. In this 
example, I edited various folders in the catalog, adding color labels 
applying star ratings, as well as editing the keywords and other 
editable metadata.

6. After I had finished editing the catalog on the laptop I was able to 
export the edits that have been applied on the laptop by creating 
a new export catalog. To do this, I highlighted All Photographs 
in the Library panel (to select all the catalog contents again) and 
chose: File ➯ Export as Catalog... Because I only wanted to 
export things like the ratings, color label and keyword metadata 
edits, I didn’t need to check the ‘Include available previews’ option. 
After all, as I was about to export back to the main library, there 
was no need for me to include the previews again.
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7. At this point I needed to either quit Lightroom or switch catalogs 
so that I could disconnect the removable hard drive from the 
laptop and reconnect it to the iMac computer again. On the iMac 
I opened Lightroom with it running the original master catalog 
and chose: File ➯ Import from Catalog... I selected the laptop 
exported catalog and clicked ‘Choose’. It was important here that 
in the Import from Catalog dialog I chose to replace the catalog 
contents using Metadata and Develop settings only.

8. Here is the master catalog on the main computer after merging all 
the metadata edits from the laptop exported catalog. As you can 
see, the color labels and ratings have now updated.
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Figure 1.6 If the exported catalog 
excludes the master negatives, then the 
folders with missing negatives will be 
displayed in red.

Limitations when excluding negatives

As was pointed out in the previous step-by-step example, you will 
encounter certain limitations when working with a catalog that has 
been exported without including the negatives. While you can edit 
most of the informational metadata, export out the edited catalog and 
reimport the information back into the main computer, that is about all 
you can really do. The Folders panel will display the catalog folders in 
red because the links to the master folders will be broken. The Develop 
module will be accessible but inoperative. You can see which develop 
settings have been used but that is all. You can use the Slideshow 
module to run slideshows (providing the pre-rendered previews are 
good enough) and you can use the Web module to generate web 
galleries. However, the Web module will constantly remind you that 
the ‘best-available previews’ are being used in place of the original 
masters. Although to be honest this isn’t always likely to be a problem 
and it may more likely make you long for a similar draft mode option 
in the normal catalog mode! With the Print module you will be able to 
make draft mode prints. Again, the print quality will be dependent on 
the quality of the pre-rendered previews.

Export and Import summary
You use the File ➯ Open Catalog... command to load individual cata-
logs and Lightroom can only run one catalog at a time. And the main 
thing to remember here is that a catalog export is always a one-way 
process. You can only ever create new catalogs and you can’t get a 
catalog export to add to an existing catalog, you can only create new 
ones.

The File ➯ Import from Catalog... command is the mechanism used 
to import catalog information from one catalog and add new catalog 
information to an existing catalog. Or you can use it to update the 
metadata information in the current catalog, as was shown in the steps 
on the previous pages.
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Catalog Settings
Towards the bottom of the File menu we have the Catalog Settings… 
item. This is a three-part preference dialog which contains several items 
that were previously located in the Lightroom 1.0 main preferences. 
I guess this is initially going to cause a little confusion because of the 
way certain preference items have been syphoned off to this submenu 
item. But it is one of those changes that once you have learned where 
the new settings are, you will soon become accustomed to the change.

General Catalog settings

Figure 1.7 shows the General Catalog settings interface. The 
Information section provides some basic information about the current 
Catalog file. If you click on the Show button this will reveal the loca-
tion of the current catalog in the Finder/Explorer.

Figure 1.7 The General Catalog Settings.
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The Backup section has the same catalog/library backup options as 
before. Personally, I wish there was an option to backup the catalog 
after you quit Lightroom, but never mind, maybe next time around… 
As before, when you come to backup the library you have the option 
to run an integrity test on the current catalog. And at the bottom there 
is the Relaunch and Optimize button. One of the most common 
problems aired on the Lightroom forums is “Why is Lightroom running 
so slowly?” There can be many reasons for this and often it can be 
due to the fact that some people have had high expectations of how 
many images they can manage on a computer system that is just not 
powerful enough or does not have enough RAM to allow them to 
do so efficiently. But the Relaunch and Optimize option can be worth 
using if you are trying to manage a large catalog of images and have 
seen a noticeable deterioration in performance.

File Handling settings

The File Handling settings shown in Figure 1.8 have been moved from 
the File Management preferences in Lightroom 1.0 and are exactly the 
same. You can adjust the Standard Preview Size to whatever is most 
appropriate for the size of your screen. If you are running Lightroom on 
a laptop, there may be no point in generating standard size previews 
that are any larger than 1024 pixels tall. If on the other hand you 
are running Lightroom on a large LCD display then it may be more 
appropriate to choose the 2048 pixels setting. As for the Preview 
Quality, I don’t see much point in choosing the High setting, since the 
Medium quality setting is good enough. I find there is not enough of a 
significant difference between the Medium and High settings to justify 
increasing the size of the Lightroom Catalog Previews.lrdata file. 

Whenever you launch Lightroom, it initially loads all the low-resolution 
thumbnails, and within 30 seconds or so, starts running checks on the 
current library contents, checking the thumbnails in order of quality. 
Lightroom will look to see if any of the standard resolution thumbnails 
need to be rebuilt first before going on to build the high-resolution, 
1:1 previews for these images. At the same time it checks the existing 
thumbnail previews against their modification dates. If any file has 
been modified since the last time a preview was built, Lightroom 
rebuilds a new set of previews, starting with a standard preview, fol-
lowed by a high-quality 1:1 preview.
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When you point Lightroom at a particular a Folder it will, as a matter 
of course, build 1:1, full-size previews of all images; Lightroom will do 
this in the background as and when it can. But you won’t always see 
every image have a 1:1 preview because the process does take a while 
to complete and it therefore depends on how long you spend with a 
particular folder in view. You can force Lightroom to generate 1:1 pre-
views by choosing: Library ➯ Previews ➯ Render 1:1 Previews. These 
large previews are useful because they speed up the time it takes to 
review images at a 1:1 zoom view, but they can also be costly in terms 
of taking up room on the hard disk. So the options available here will 
allow you to Automatically Discard 1:1 Previews after a designated 
period of time or not at all, if you think you have the drive capacity to 
handle a Catalog Previews.lrdata file that keeps growing in size.

Figure 1.8 The File Handling Catalog Settings.

page references
Preview cache 311–314
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Metadata settings

As you enter metadata for keywords and other editable metadata 
fields, it can save you time to have the Offer suggestions from 
recently entered values option checked in the Metadata Catalog 
settings (Figure 1.9). This was previously switched on by default in 
Lightroom 1.0, but you can now choose whether to keep it switched 
on or not, or you can click on the Clear All Suggestion Lists button 
to reset the memory to clear all memorized words. Most of the time, 
auto completion can be a useful thing to have active. However, there 
are times when entering certain metadata that the auto tool can 
become a pain. For example, when I do a model casting and enter in 
the names of models in the Title field of the Metadata panel in the 
Library module, I don’t find auto-completion particularly helpful. Every 
model’s name is different and sometimes I find it easier to switch this 
off rather than fight with the suggestions that Lightroom is making on 
my behalf.

The Write develop settings to XMP for JPG TIFF and PSD is a 
new option that provides you with an option to distinguish between 
writing the develop settings metadata to the XMP space for all files 
including JPEGs, TIFFs and PSDs, or to raw files and DNG files only. This 
is a preference that predetermines what gets written to the XMP space 
when you make an explicit command to save the file metadata out to 
a file, such as when you choose: Metadata ➯ Save Metadata to File (in 

Figure 1.9 The Metadata Catalog Settings.

page references
sharing metadata 316–317
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the Library module) or Photo ➯ Save Metadata to file (in the Develop 
module), or use the new shortcut: Command–S (Mac), Control–S 
(PC), or, when the Automatically write changes into XMP option is 
switched on.

OK, let’s take a closer look at what this XMP setting business is all 
about. The XMP space is the hidden space in a document such as 
a JPEG, TIFF, PSD or DNG file that is used to write the metadata 
settings to. In the case of proprietary raw files it would be unsafe for 
Lightroom to write to the internal file header, so .xmp sidecar files are 
used instead to store the XMP metadata. The XMP metadata includes 
everything that is applied in Lightroom. It includes the editable meta-
data information such as the IPTC information applied via a metadata 
template. It includes keywords, file rating flags and color labels. And it 
also includes the develop settings that are applied via Quick Develop 
and the Develop module.

The ability to save develop settings with the file can be a mixed bless-
ing. If you are sharing images exported from Lightroom as individual 
images or as an exported catalog with another Lightroom user, you will 
most definitely want to share the develop settings for all the images 
that are contained in the catalog. But if you are sharing files from 
Lightroom with Bridge 2 as part of the Adobe Creative suite 3, this can 
lead to some unexpected file behavior when you open non-raw files 
via Bridge 2. Basically what will happen is that raw and DNG images 
that have had their develop settings modified via Lightroom will open 
via Camera Raw in Bridge exactly as you expect to see them, since 
Bridge 2 is able to read the settings that were created in Lightroom. 
However, where you have edited a non-raw file such as a JPEG, TIFF or 
PSD image using the Develop settings in Lightroom, and the develop 
settings have been written to the file’s XMP space, Bridge 2 will now 
consider such files to be raw files and will open them up via Camera 
Raw rather than open them directly in Photoshop. That’s what I mean 
by mixed blessings. If you want Lightroom to retain the ability to 
modify the XMP space of non-raw files for data such as file ratings, 
keywords and labels etc. but exclude storing the develop settings, you 
should uncheck the ‘Write develop settings to XMP’ option. If you 
do this, your Lightroom develop settings for non-raw files will only 
get written to the catalog and they won’t get exported when you 
choose ‘Save Metadata’. But raw and DNG files will continue to be 
modified as before. On the plus side, you will never be faced with the 
confusion of seeing your non-raw images such as JPEGs unexpectedly 
default to open via Camera Raw when you try to open them up in 
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Photoshop CS3. The downside is that if you modify a non-raw image in 
Lightroom using the Develop settings, these changes will only be seen 
in Lightroom and not in Bridge.

The Automatically write changes into XMP option is normally 
unchecked. At first sight it would seem like a good thing to have 
this switched on all the time so that Lightroom continually updates 
the XMP metadata as any changes are made via the program. 
Unfortunately, doing so can really slow down Lightroom’s performance. 
For this reason alone it is better to have this option switched off. 
When this option is disabled all Lightroom metadata edits are stored 
in the internal catalog file only. If you intend to export images from 
Lightroom either singly or as an exported catalog, then you can simply 
use the Save Metadata command: Command–S (Mac), Control–S (PC) 
to write the metadata directly to the selected files.

Summary of metadata saving behavior
To help explain the settings and how they affect image files after 
being modified in Lightroom and then viewed in another program, I 
have used the following tables to summarize how these options affect 
the way these different file formats will be handled. However, these 
tables do assume that you are using Photoshop CS3 and have updated 
Camera Raw to the latest 4.1 version.

Automatically write 
changes into XMP

Write develop 
settings to XMP for 
JPG, TIFF and PSD

Save Metadata 
command

JPEG, TIFF, PSD 7 7

Proprietary raw files 7 7

DNG 7 7
 

1. If a photo in Lightroom is modified using the settings shown here 
with ‘Automatically write changes into XMP’ and ‘Write develop 
settings to XMP for JPG, TIFF and PSD’ switched on, then all 
adjustments made to a photo in Lightroom will automatically be 
saved to the Lightroom catalog and also saved back to the original 
image file. In the case of proprietary raw files, the XMP metadata 
will be written to an XMP sidecar file and when opened via Bridge 
2, will (as you would expect) open via the Camera Raw dialog with 

page references
sharing metadata 316–317
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the same develop settings that were applied in Lightroom. In the 
case of DNG files, the XMP metadata will be written internally to 
the file and these too will open in Camera Raw.

 In the case of JPEG, TIFF and PSD files, the XMP data will be saved 
inside the file header itself. However, because you are also saving 
the Lightroom develop settings, these files will default to opening 
in Bridge 2 (as part of the Creative Suite 3) always using the Adobe 
Camera Raw dialog.

2. If the ‘Automatically write changes into XMP’ option is disabled, 
the same rules will apply as before, except now the metadata 
edits will only be saved to the Lightroom catalog. If you want the 
metadata edits to be saved to the files’ XMP metadata space. You 
have the option to manually do so using the Save Metadata com-
mand. In this example, the Write develop settings to XMP for JPG, 
TIFF and PSD option is switched on, so you will also be saving the 
Lightroom develop settings to the files’ metadata space.

 Now if you were to open a JPEG, TIFF or PSD image that had been 
edited in Lightroom without using the Save Metadata command, 
such files will open from Bridge 2 directly into Photoshop and will 
not open via the Camera Raw dialog. At at the same time, the 
image ratings, metadata keywords and any other information that 
had been entered in Lightroom will also not be visible in Bridge 2 
(or any other program outside of Lightroom). If you were to use 
the Save Metadata command before inspecting these photos in 
Bridge, then all the metadata will get saved to the XMP space and 
we are back to the same scenario as in step 1 where the non-raw 
files will default to open via Camera Raw, which is perhaps not 
what the customer wanted!

Automatically write 
changes into XMP

Write develop 
settings to XMP for 
JPG, TIFF and PSD

Save Metadata 
command

JPEG, TIFF, PSD 7 7

Proprietary raw files 7 7

DNG 7 7
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3.  Now let’s look at what happens when the ‘Write develop settings 
to XMP for JPEG, TIFF and PSD’ is disabled.

 In this example, if you use the Save Metadata command (or if 
‘Automatically write changes into XMP’ is switched on) then 
anything that is done to edit the metadata of a non-raw photo in 
Lightroom, except for the develop settings, will get saved to the 
files’ XMP metadata space. The develop settings will get saved to 
the Lightroom catalog of course, but they won’t get written to the 
file’s XMP space.

 In this scenario, JPEG, TIFF and PSD files that have been edited in 
Lightroom will open from Bridge 2 directly into Photoshop without 
going via the Camera Raw dialog. All the other metadata that has 
been edited in Lightroom will be preserved and remain accessible 
in other programs, all except for the develop settings. Overall this 
is a useful configuration for preserving the informational metadata 
in non-raw files that have been modified via Lightroom. But the 
develop settings won’t be transferred and hence the appearance 
of such images will not always match between how they look in 
Lightroom, and how they look in other programs.

 Because this setting only applies to non-raw files, all proprietary 
raw and DNG files that have been edited in Lightroom will preserve 
their informational metadata and their appearance when viewed 
in Bridge 2, and will open as expected via the Bridge Camera Raw 
dialog.

Automatically write 
changes into XMP

Write develop 
settings to XMP for 
JPG, TIFF and PSD

Save Metadata 
command

JPEG, TIFF, PSD 7

Proprietary raw files 7

DNG 7
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Lightroom 1.1 and Camera Raw 4.1
As you are probably aware, the Lightroom 1.1 update has followed on 
straight after the Adobe Camera Raw 4.1 update for Photoshop CS3 
and both share the same Camera Raw processing engine. This means 
that any development adjustments that are applied in one program can 
be recognized and read by the other. However, there are a few things 
you need to bear in mind here.

Viewing Lightroom edits in Camera Raw

We have just looked at saving metadata in Lightroom, so the first point 
is to remember to always save the metadata edits out to the files’ XMP 
space if you want Camera Raw to read the develop adjustments made 
in Lightroom. If you don’t save the metadata to the files’ XMP space, 
the edit changes you make will not be read by Camera Raw. But the 
second and more important point is that only Camera Raw 4.1 will be 
able to read all the develop adjustments that are applied in Lightroom 
1.1. Any version of Camera Raw prior to 4.1 will not be able to make 
full sense of the new develop adjustment settings. Older versions of 
Camera Raw are still capable of reading the develop settings it under-
stands such as white balance and exposure. It is just the new things 
like the sharpening controls that won’t be fully interpreted. So all that 
subtle work tweaking the Amount, Radius, Detail and Masking sliders 
in the Detail panel will get reduced to the Amount setting only being 
read by an earlier version of Camera Raw. The situation isn’t so bad 
that you won’t be able to read anything in older versions of Camera 
Raw, but for an interactive workflow where you need to maintain 
compatibility between Lightroom and Photoshop, you are going to 
have to make sure that you are using Photoshop CS3 with the very 
latest version of Camera Raw.

note
You can access the latest version 

of camera raw for Photoshop 

and Bridge by going to the adobe 

website: www.adobe.com/products/

photoshop/cameraraw.html.
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Figure 1.10 To keep the Camera Raw edits in sync with Lightroom, you need to 
make sure that the Camera Raw settings are always saved to the .xmp files.

Figure 1.11 You can use Synchronize Folder to run a quick scan for metadata updates.

Viewing Camera Raw edits in Lightroom

If you want your Camera Raw edits to be visible in Lightroom then you 
also need to make sure that the image adjustments applied in Camera 
Raw are saved to the file’s XMP space. To do this, launch Bridge, go 
to the Bridge CS3 menu and choose: Camera Raw Preferences... 
This will open the dialog shown in Figure 1.10 where you will need to 
go to the Save image settings in menu and select: Sidecar “.xmp 
files”. This will ensure that the Camera Raw settings are always saved 
to the XMP space by default.

Keeping the Lightroom edits in sync

Lightroom should display a metadata status conflict warning in the grid 
cells with an upward arrow whenever it appears that the metadata has 
been edited externally. You can click on this arrow to pop the dialog 
shown on page 374. If there is no warning, but you think the metadata 
has been updated, then you can choose Metadata ➯ Read Metadata 
from files in the Library module or Photo ➯ Read Metadata from 
file in the Develop module. Or choose: Library ➯ Synchronize Folder. 
This will also allow you to run a quick check to make sure everything is 
in sync.
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Synchronizing Lightroom and Camera Raw 4.1

1. Let’s show here a simple illustration of how to keep a set of photos 
viewed in Lightroom 1.1 and Camera Raw 4.1 in sync. In this first 
screen shot you can see a folder view of some photographs that 
have been processed in color.

2. Over in Camera Raw 4.1 I opened the same selection of photos, 
converted one of the pictures to grayscale and synchronized this 
setting change across all of the selected images.



374 ChApTer 1 General menu items
This PDF was made available free of charge via: www.peachpit.com (not for resale)

3. When I returned to Lightroom the ‘out-of-sync’ photos should now 
display a metadata status change warning icon with an upward 
arrow, indicating that the metadata has been changed externally. 
A click on the warning icon followed by a click on the Import 
Settings from Disk button in the dialog shown here, imported all 
the Bridge adjusted settings into Lightroom.

4. The externally adjusted settings now appeared updated in Lightroom.
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Metadata Browser categories
If you check the Metadata Browser panel in the Library module, notice 
that there are now four new add categories: Aperture, Shutter 
Speed, ISO Speed Rating and Label. These additions are pretty 
self-evident in that they provide extra ways to filter the images that are 
displayed in the content area. In the case of ‘Label’ this is exactly the 
same as clicking on a color label swatch in the Filters section of the 
Filmstrip. In order to make the Metadata Browser panel more manage-
able you can use the Catalog Settings to customize which items are 
visible in this panel.

Importing
I have already covered Import from Catalog (see page 357), which 
leaves the other import options that are now divided into: Import 
Photos from Disk… and Import Photos from Device… This means 
that you can choose from the File menu whether to import photos 
from a disk location or from a camera card mounted on the desktop.

But note that if you have a card mounted on the computer and you 
click on the Import button in the Library module, you’ll still have a 
choice of whether to import from a card or from the disk.

Figure 1.12 If a camera card is mounted on the desktop, the Import dialog still 
offers a choice of import options.

And if you are importing from a camera card there is a new option to 
Eject card after importing, which will do just that after an import 
has been successful. The advantage of this is that you won’t have to 
manually eject the card via the Finder/Explorer. You can just unplug 
the disk after the import has been completed. Some people prefer 
to delete the camera files first before ejecting and then reformat the 
card in the camera before shooting more images. That’s how I like to 
do things because often on a busy shoot it can get confusing to put 
a card back into the camera and if you see there are still images on it, 
not always know if it is safe to reformat or not.

page references
importing photos 38–53
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As you can see, the redesigned Import dialog (see Figure 1.13) is more 
compact and the Don’t re-import suspected duplicates option 
is actually a rewording of the previous ‘Ignore suspected duplicates’ 
option. The new wording is now clearer I think.

Figure 1.13 Import Photos from Device import options.

Exporting and keyword hierarchy
Over in the Export dialog in Figure 1.14 there has been a minor addi-
tion to the dialog box options.

The Minimize Embedded Metadata option that allows you to export 
without including custom informational metadata such as keywords, 
has been moved to a new Metadata section of the Export dialog. 
And alongside it is a new Write Keywords as Lightroom Hierarchy 
option. This is checked by default and will ensure that keywords are 
always written to a file’s XMP space such that the keyword hierarchy 
is preserved when the keyword metadata is previewed on another 
computer running Lightroom where perhaps the keywords used are 
unknown or do not share the same hierarchy.
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For example, let’s say you have two computers that share the same 
controlled vocabulary, i.e. they both share the same keyword hierarchy 
structure. If you were to export a photo from one computer and 
import it into the other, then the ‘Write Keywords as Lightroom 
Hierarchy’ option won’t make any difference because the keyword 
hierarchy for the individual keywords will be recognized anyway. Please 
note that I am talking about a normal export and import here, not 
about the new export/import catalog command. But if this option is 
unchecked and the second computer does not share the same informa-
tion, the keywords will otherwise be output as a flat View list without 
a Lightroom-recognized hierarchy.

So if you happen to use a keyword hierarchy that uses: California > 
USA > Places, that hierarchy will be preserved so long as either the 
computer you importing the photo to already knows this hierarchy 
relationship or the ‘Write Keywords as Lightroom Hierarchy’ option is 
checked. If it is not checked, the keywords will be exported as a flat 
list: California, USA, Places.

Note that in the Export dialog shown here that the DNG export 
settings are different. These new options will be discussed later in the 
Lightroom 1.1 Preferences chapter.

Figure 1.14 The Export dialog.

page references
exporting photos 34, 107–108

Keyword Hierarchy 96
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Filters
The File ➯ Filters submenu duplicates the menu items that already 
appear in the Library module’s Library menu. The reason why the 
menu list appears twice in Lightroom is so that the Filtering can always 
be accessible via the File menu, when working in any of the other 
modules.

In the example shown in Figure 1.15, you can see how the Filters 
submenu allows you to filter by Rating, Flag, Color Label or Copy 
Status (which is a new filtering option found in 1.1). Note how the 
options provided here in the Filters menu are identical to the Filters 
section found in the Filmstrip. For example, you could filter the images 
displayed in the content area to show the Virtual Copies by choosing 
File ➯ Filters ➯ Filter by Copy Status ➯ Virtual Copies. Or instead, 
you could more simply click on the Virtual Copies filter button in the 
Filmstrip panel.

Figure 1.15 You can now use the File ➯ Filters ➯ Filter by Copy Status ➯ Virtual 
Copies to filter the catalog to display photos that are virtual copies only. But it is 
probably simpler to use the button circled here in the Filmstrip to achieve the same 
filtered outcome.

page references
Filtering images 76–79
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Edit menu

The Edit menu now contains a series of Select by submenu items. 
These provide a mechanism for making filtered selections while keep-
ing all the images in a current filtered view (either filtered by folder or 
whatever other means) visible. Here is how it works.

1. Select a folder of images and then go to the Edit menu and 
choose a Select by submenu item. In this example, I chose: Edit ➯ 
Select by Rating ➯ one star.

Figure 1.16 The Edit menu that is common to all Lightroom 1.1 modules.
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2. Here you can see that all the one star images have now been 
selected (these are the photos with the light gray cell frame 
borders). I then went to the Edit menu again and chose Select by 
Color Label ➯ Add to Selection ➯ Yellow.
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3. By using Add to Selection I was able to add all the yellow color 
label images to the one star-rated images. Of course, some of the 
yellow label images were already selected by the one star rating. 
But I could have used the Select by Color Label menu to add the 
yellow label images to a red yellow selection and then used the 
Select by Rating ➯ Intersect with Selection menu to select just 
the one star rated photos that had a red or yellow label. The Edit 
➯ Select by menu options can be used in this way to create any 
number of selection rules. This can be very useful when managing 
large folders of photos.
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Help menu

Figure 1.17 The Help menu that is common to all Lightroom 1.1 modules. This 
screen shot shows the Library module Help menu, but the other modules look similar 
except they will have help items and help shortcut relevant to the module you are in.

Figure 1.18 The Lightroom 1.1 off-line Help guide. This guide is installed with the 
program and will display the contents in a Web browser format.

And last, the Help menu which has two new additions. Figure 1.17 
shows the Help menu found in the Library module. If you select 
Library Help, you can access the off-line Lightroom 1.1 user guide 
where you can browse the help guide options for the current module 
(see Figure 1.18 below).

page references
Help menu 35
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Figure 1.19 The Lightroom Presets system folder.

If you select the Go to Lightroom Presets Folder, you can go directly 
to the system Lightroom folder in the Application support submenu. 
This will make it easier for you to access the various Lightroom preset 
folders. Advanced users will find this useful for accessing the folders 
where the saved template settings live.
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photograph: Cape point, rsA, © martin evening 2005
Canon eos 1 ds | 24 mm | 200 iso | f8 @ 1/800th 



The Library module2

In the General menus chapter we looked at the new look 

menus that are common to all the modules in Lightroom 1.1 

such as the File, Edit and Help menus. In this next chapter I am 

going to focus on what has changed in the Library module in 

the Lightroom 1.1 update.
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Library Menu

Filters
As I mentioned before, the Filter items highlighted here are simply a 
duplicate of the File ➯ Filters submenu and the Filters section found in 
the Filmstrip. 

Figure 2.1 The Library menu in the Library module.

Figure 2.2 Here is a view of the Library menu showing how to filter all the ‘picked’ 
photos and below that a detail view of the Filmstrip, with the Picks filter (circled) made 
active, which is probably easier to use than navigating the Library menu.
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Figure 2.3 In this Folders panel view, the Model castings folder has been 
highlighted. It contains two subfolders. You will note that the photo count in these 
two folders does not add up to 159. This is because there are 12 photos located in the 
Model castings folder that are not contained in any subfolder. As mentioned in the 
text, ‘Include Photos from Subitems’ will allow you to filter all the photos in the Model 
castings folder. When it is switched off you can filter the root level folder contents only 
and exclude all subfolders.

So, for example, I could filter a folder of images by choosing Library 
➯ Filter by Flag ➯ Picks to filter the images so that only those photos 
marked as flagged are visible. As pointed out in the General menus 
chapter, the Filters section of the Filmstrip is still a pretty handy way 
to go about doing the same thing. In this case, you could simply click 
on the Flag icon circled here in order to make only the flagged photos 
visible.

Subfolder filtering
The Include Photos from Subitems filter is also new. This lets you 
determine whether to include or exclude the photos contained in 
any subfolders, thereby allowing you to hide photos that are in any 
subfolders.

In the Folders panel view shown in Figure 2.3, I have selected a folder 
called ‘Model castings’ that contains 159 photos of which 147 photos 
are contained in its two subfolders. This means there are 12 photos 
floating around in the Model castings folder that are not assigned 
to either of these two subfolder items. If I were to deselect ‘Include 
Photos from Subitems’ in the Library menu, any filtered searches I carry 
out will apply just to these 12 photos and exclude the other 147.

page references
Filtering images 76–77
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Synchronize Folder
Toward the bottom of the Library menu is the Synchronize Folder… 
This is really an update of the previous ‘Check for Missing Photos and 
Folders’ option that you could only access via the contextual menu (i.e. 
you had to know to right mouse-click on a folder to access this option). 
Now it is up there in the Library menu where it will be far more 
discoverable (as well as remaining part of the contextual menu). But 
the new Synchronize Folder command is a lot more effective because 
it allows you to really keep your folders updated with any changes 
that may have been made outside Lightroom. What this means is that 
should you happen to change the contents of a folder that has already 
been imported into Lightroom, the Synchronize Folder command will 
get Lightroom to update all the information about the folder contents 
such as looking for images that may have been added or removed from 
that folder. The Synchronize Folder command can also scan to see if 
the metadata has been updated outside Lightroom.

Let me give you an example of how this would work. Suppose you 
import a folder of images into Lightroom either by copying them to 
the Lightroom catalog folder or by choosing ‘import by reference to 
a current disk location’. Now let’s suppose that you added some new 
images to that folder at the system level. If you did this when using 
Lightroom 1.0 or one of the earlier betas, there would be no easy way 
to tell Lightroom to automatically check to add these new additions 
to the catalog. But in Lightroom 1.1, if you select this particular folder 
and choose Library ➯ Synchronize Folder, Lightroom 1.1 will check for 
new photos and give you the option to Import these and update the 
catalog information about what is in that folder.

Figure 2.4 The Synchronize Folder dialog.
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If you check the Import New Photos option in the Synchronize Folder 
dialog, you can choose to simply import and update the catalog, or 
you can choose Show import dialog before importing, which will 
open up the Import Photos dialog shown in Figure 2.5. The default 
setting for ‘Synchronize Folder...’ will automatically import the files 
to the same folder they are in currently without showing the Import 
dialog and without modifying the filename, develop settings, metadata 
or keywords. Perhaps the only reason for choosing to show the Import 
Photos dialog when synchronizing a folder would be if you wish to 
adjust any of these settings as you import and update the Lightroom 
catalog. Note that if you have removed any photos from the folder 
outside Lightroom, Synchronize Folder will also remove those files 
from the catalog, thereby keeping the Lightroom catalog completely 
updated for all new additions as well as any photos that are no longer 
located in the original folder.

Scan for Metadata updates works identically to the ‘Read metadata 
from files’ option in the Library module Metadata menu (see page 
399). For example, if you edit the metadata in any photos outside 
Lightroom, such as in Bridge or some other program where the meta-
data edits you make are saved back to the file’s XMP header space or 
saved to an XMP sidecar file, you can use Synchronize Folder to sync 
any metadata changes to the Lightroom catalog.

Figure 2.5 The Import Photos dialog.

page references
import Photos 38–40
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Updating previews
The Library ➯ Previews submenu commands will now apply to all 
currently filtered images regardless of any selection that you have in 
place. So for example, if you had 37 photos filtered in the content area, 
but only one photo was selected, and you chose Library ➯ Previews 
➯ Discard 1:1 Previews, the warning dialog shown in Figure 2.6 will 
appear:

Previously, Lightroom would have asked if you wanted to discard the 
previews for the selected images only. The same also applies when 
choosing to generate standard sized or 1:1 previews. Lightroom will 
now check the status of all currently filtered photos and ignore any 
photo selections.

Figure 2.6 The Discard Photos warning dialog.

page references
Previews 312–314
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Photo Menu

The new Go to Folder in Library menu item will always take you 
to the Folder in the folder panel for whichever photo is currently the 
‘most selected’ in the Library module. For example, if you have photos 
in the content area that are based on a Collection or a Keyword 
selection, the photos you are looking at could have originated from any 
number of separate folders. By using ‘Go to Folder in Library’ you can 
quickly jump to the folders for any particular photo.

The Create Virtual Copy command is one that you will want to use 
a lot of the time. Creating virtual copies of photos is a great way to 
experiment with creating different versions of photographs, such as 
black-and-white versions or different croppings. So it is about time that 
it was given it’s own keyboard shortcut: Command + ‘ (Mac), Control 
+ ‘ (PC). Once you have created one or more virtual copies you can 
then choose the new Set Copy as Master command to make any 
virtual copy version of an image become the new master version (and 
make the old master version a virtual copy). 

Figure 2.7 The Library module Photo menu.

page references
Virtual copies 80, 218

tip
if you right-click on a photo in the 

library grid, you can access the 

contextual menu which will also 

allow you to choose ‘Go to Folder in 

library’, or ‘show in Finder’.
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Removing and deleting photos
The photo deletion process did cause a certain amount of confusion in 
Lightroom 1.0 because some people were unclear about the distinction 
between deleting a photo to remove it from the Lightroom catalog and 
deleting a photo to remove it from the catalog as well as deleting it 
from your hard drive by sending it to the trash.

Now if you hit the delete key you will be faced with a slightly changed 
dialog (shown in Figure 2.8) that offers (as before) the option to 
simply remove the current photo(s) from the catalog, or the option 
to delete it completely from the disk. Note here that selecting 
Delete from Disk… will remove the photos from the catalog and 
then send them to the system trash/recycle bin. The handy shortcut: 
Command–D (Mac) or D key (PC) will select the Delete from Disk… 
option. Although the warning message says that this process cannot 
be undone, it is not in fact a complete deletion. The photos you delete 
can still be accessed via the trash/recycle bin. It will only be when you 
choose to empty the trash/recycle bin that the images will truly be 
deleted forever.

So if you are aware of this difference and wish to avoid having to go 
through the above dialog each time you hit delete to remove photos 
from the catalog, you can instead now use the Photo ➯ Remove 
Photos from Catalog command, or the Option + Delete (Mac), Alt + 
Delete (PC) shortcut.

Figure 2.8 The Delete Photos warning dialog.

page references
removing images 82
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Metadata Menu

The Painter tool
In the Library module toolbar you can access the new Painter tool by 
choosing Enable Painting (or, you can use the Command+Option–K 
(Mac), Control+Alt–K (PC) shortcut). The Painter tool now replaces the 
previous Keyword Stamper tool. The Painter tool can be used the same 
way as the Keyword Stamper: for repeatedly applying a keyword to 
images in the content area, except the Painter tool now allows you to 
do much more than stamp single keywords. 

1. I have highlighted the Painter tool here in yellow, as seen in the 
Library module toolbar. To work with the Painter tool, just click on 
this icon to activate it. The spray can will undock itself from the 
toolbar and replace the normal cursor icon as you move about the 
content area.

Figure 2.9 The Library module Metadata menu.

page references
Keyword stamp tool 97
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2. Once the painter tool has been made active you can scroll down its 
tool options to choose what kind of setting you want to apply with 
it. For example, the list here is currently set to work with Settings 
and when selected, another list next to it will let you choose from 
a list of saved Develop presets. If you select Rotation, the menu 
will change to allow you to select a specific rotation or to flip an 
image. If Metadata is selected, the menu list will let you choose 
from pre-saved metadata templates. And likewise, if Rating, Pick 
or Label are selected, you are also offered a choice of settings to 
work with. Here I selected Keywords.
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3. With Keywords selected, you can enter the keyword you want 
to apply in the empty field next to the Painter tool menu. As 
you enter a keyword, Lightroom will auto-complete the text as 
you type from previous or recently used keywords. In this step 
I wanted to apply the keyword ‘Details’. We are now ready to 
put the Painter tool to use. In the screen shot shown here I have 
deliberately made the Painter tool bigger than it normally appears 
in order to make it stand out more. Basically, you just drag with 
the Painter tool anywhere in the content area. Dragging with the 
tool over any photo will apply the currently active setting to it. In 
this example I used the Painter tool to ‘paint’ the Details keyword 
to specific photos. When you have finished using the Painter 
tool, click in the empty area of the toolbar where the Painter tool 
normally lives, to exit working with it.

note 
You can still use mouse clicks to 

apply settings with the Painter tool, 

but dragging is a more effective 

way to work with it when applying 

settings across multiple images in 

the library content area. the Painter 

tool also has two modes of opera-

tion. When you first use it to apply 

a setting you will see the Painter 

tool in ‘spray can’ mode using the 

icon shown on the left. But when 

you hover over an image that has 

just had the Painter tool treatment 

note that the icon changes to show 

an eraser ( ). if you click or drag in 

this mode you can undo any settings 

that have just been applied using the 

Painter tool.
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Metadata editing and target photos
Prior to the 1.1 update, if you had a bunch of images selected in the 
content area and went to the Metadata panel, the metadata informa-
tion would have displayed <mixed> values whenever the file attributes 
all varied. Only those values that remained constant – such as the 
copyright information – would display.

When Show Metadata for Target Photo Only is selected in the 
Metadata menu, the Metadata panel display will look like the version 
shown on the right in Figure 2.10 in which it will now be possible to 
read the individual metadata information for the ‘most selected’ or 
‘target photo’.

In the Figure 2.11 example I have selected all of the photos from a 
recent model casting and the Metadata panel is displaying the informa-
tion for the photo that is the most highlighted of all the selected 
images (the target photo). By using the Command + arrow keys (Mac) 
or Control + arrow keys (PC), one can navigate from one image to 
the next without losing the active photo selection and reading the 
metadata information for each image as you do so.

Figure 2.10 The left shows how the metadata information displayed in Lightroom 
1.0 when more than one photo was selected and the photos all had different 
metadata information. The right shows how the Metadata panel in Lightroom 1.1 will 
display the information for the most selected (target) photo when ‘Show Metadata for 
Target Photo Only’ is selected.

page references
metadata panel 83–89
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in the ‘Show Metadata for Target Photo Only’ mode, the one thing you 
do need to be aware of is that you are only able to edit the metadata 
on a per-image basis. This is a good thing because it means that you 
can keep an image selection active and edit the metadata of individual 
images. But a lot of people will be accustomed to making image selec-
tions and then using the Metadata panel to edit settings globally across 
the selection. So just beware that although this menu item can prove 
useful (for the reasons I have described), you probably won’t want to 
have this enabled all the time.

Figure 2.11 An example of the Show Metadata for Target Photo Only function in 
use. Note that although all the photos have been selected and the Titles are different, 
we can now read the information for the most selected photo. 
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Saving and reading metadata
Another pain point for newcomers to Lightroom has been the question 
of ‘how do you save images?’ In our very first computer lesson we all 
learned how important it is to always save your work before you close 
down a program. Lightroom 1.0 confused a lot of people because 
there was no ‘save’ menu item and they were left wondering if they 
would lose all their work after they quit Lightroom. Of course you real-
ize soon after using the program that work is saved automatically. Even 
if Lightroom suffers a crash or there is a power failure, you shouldn’t 
necessarily lose all your work. But Lightroom 1.1 now includes a Save 
Metadata to Files command in the Library module Metadata menu. 
What this does is to force an export of the metadata information from 
the Lightroom internal catalog to the actual image file.

It is important to remember here that as you carry out any kind of 
work in Lightroom – whether you are adjusting the develop settings, 
applying a color label or star rating, or editing keywords or other meta-
data – these edits are all stored in a central Lightroom catalog on your 
hard disk. For simplicity’s sake we can summarize these by grouping 
them under the term ‘metadata edits’. So when you do anything to an 
image in Lightroom, you are not changing the fundamental structure 
of the image. The whole concept of Lightroom is built around the idea 
that the imported images are the master negatives and Lightroom 
records the changes made as metadata information that is always 
stored separately to the image data. The Lightroom catalog is the 
central location where all metadata edits are stored, but the metadata 
edits can also be stored with the photo file itself. In the case of JPEG, 
TIFF, PSD or DNG images, there is a dedicated space within the file’s 
header that can be used to store the metadata. With proprietary raw 
files, this has to be stored separately in what is known as an XMP 
sidecar file.

When discussing the Metadata Settings in the File ➯ Catalog Settings 
dialog previously (see page 368), I mentioned how the ‘Automatically 
write changes into XMP’ option would record metadata changes to 
the file as well as to the Lightroom catalog, and why it was best to 
leave this unchecked. Of course, it sounds like a good idea to have the 
metadata edits back up to the file as well as to the central catalog, 
but doing so can really slow you down in Lightroom; so that’s why it 
is best to leave this switched off. Previously in Lightroom 1.0, we had 
the Metadata ➯ XMP ➯ Export Metadata to XMP menu item. This has 
now been replaced by the simpler ‘Save Metadata to Files’ command 

page references
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with the easy to remember Command–S (Mac), Control–S (PC) key-
board shortcut. In practice I’d recommended leaving the ‘Automatically 
write changes into XMP’ Catalog setting switched off. When you are 
working in the Library or Develop module, use the Command–S (Mac), 
Control–S (PC) shortcut every time you wish to export and update the 
metadata to a photo or a group of selected photos. In the long run 
this will allow you to work much quicker than having the auto update 
option running in the background.

Also in the Metadata menu is The Read Metadata from Files menu 
option. This replaces the previous ‘Metadata ➯ XMP ➯ Import XMP 
Metadata from File’ menu item which basically means you can use 
the ‘Read Metadata from Files’ menu command to ask Lightroom to 
explicitly read in the metadata from a particular photo or group of 
selected photos.

To summarize, Save Metadata to Files and Read Metadata to Files 
allow you to update the metadata to and from the photo files while 
working in Lightroom. These provide manual controls for updating the 
metadata in the files. But remember that the new ‘Synchronize Folder’ 
command discussed on page 388, will also allow you to achieve the 
same thing.

Updating DNG files
The DNG file format has been around for several years now and is 
widely adopted as a preferred format for archiving raw camera files. 
For all its benefits, one problem has been the inability to update the 
JPEG preview. This was not necessarily a problem if you were using 
DNG in Bridge or Lightroom, since the preview was referenced by 
the file preview cache and rebuilt when transferring a DNG file from 
one Lightroom/Bridge setup to another. But this approach was less 
convenient when working with other DNG-aware programs such as 
iView Media Pro. 

The Update DNG Previews & Metadata command in the Metadata 
menu does two things: it updates the metadata the same way as the 
Save Metadata to Files command does. But in addition it also rebuilds 
the JPEG preview contained within the DNG file. The section coming 
up about the new Preferences in Lightroom 1.1 explains the new JPEG 
preview options for DNG files that are exported from Lightroom.

page references
dnG format 39, 49,
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The Library module interface

Figure 2.12 Here is an overview of the Library module interface where I have 
highlighted all the main interface changes in yellow. 

Figure 2.13 On a Mac, you can  command + click on the title bar to view the 
catalog file directory path.

Catalog path (Mac only)
If you hold down the Command key and click anywhere on the catalog 
name in the title bar, you can access the path location for the current 
Library catalog. This allows you to quickly locate where the current 
catalog is stored. But note that this is a Mac-only feature.
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Find panel
On the face of it, the Find dialog (shown in Figure 2.14) has under-
gone a cosmetic makeover. The top section is better laid out so that 
users are more clearly aware that they can select different Text criteria 
to search by, other than ‘Anywhere’. The Rule section, which is now 
placed beneath, is also more prominent.

Let’s recap how the Find panel works. To carry out a text search you 
check the box marked Text and select what kind of text you want to 
search, such as by ‘Filename’. You would then combine this with a rule 
such as Contains (where there is a partial match), Contains All (for 
an exact match), Doesn’t Contain (to exclude files that match the 
text entered below), Starts With (obviously anything that begins with 
the phrase entered) and Ends With (for anything that ends with the 
phrase entered). For example, you could use the Text search section 
to search specifically by ‘Filename’ using a ‘Contains’ rule and enter 
the phrase you are looking for in the text field below. I use this search 
method quite a lot whenever clients make their final image selections 
and send me a list of filenames. All I need to do is search by entering 
the last four digits.

Copy Name searches

If you look more closely at the text search options you will see that you 
can also search by Copy Name, which is a new metadata term that 
has been added to Lightroom 1.1. Copy Name is discussed more fully in 
the Metadata panel section later, but basically you can use this search 
term to search the copy names that have been used for all your virtual 
copy images.

Empty field searches

In the Title and Caption sections you will find: Is Empty and Isn’t 
Empty rules and in the Keywords section: Are Empty and Aren’t 
Empty. The purpose of these rules is to let you search for photos 
where no title, caption or keywords have been added, or alternatively 
select only those photos that do have captions titles or keywords. Note 
that when either of these rules is selected, the field search is overriden 
and the search field box dimmed.

Figure 2.14 Here is an example of a 
Find panel text search in which I have 
asked Lightroom to search all Metadata 
for text that contains the phrase ‘ann’ 
anywhere in the metadata text, be it at 
the beginning the middle or the end.

page references
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Date searches

Instead of using the term ‘Capture Time’ to search by date, the term 
Date is now used (see Figure 2.15). This change now more accurately 
reflects what the EXIF ‘Date Time Original’ field actually means since 
this field does not strictly always refer to capture date. It could refer to 
the date a file was scanned or the date that a new Photoshop docu-
ment was created. I’ll be discussing later the new changes to the way 
date capture and date time information is displayed in the Metadata 
panel.

If you check the popup menu shown here note that there are some 
new date search settings. You can now also search by: Today, This 
Week, Yesterday and Last Week.

Count display in Folders panel
When carrying out a filtered search via the Find panel, a true count 
of the number of files found in a particular folder/collection/matching 
keyword will now be shown as how many numbers of files there are 
out of the total number of images. In the Figure 2.16 example you can 
see how a text search has resulted in a count revision in the Folders 
panel underneath.

Navigator view of Folders panel contents
Another new Folders panel feature is the way the Navigator view will 
update as you roll the mouse over the Folder list. The Navigator will 
preview the first photo that appears in the folder, thus providing a 
visual reference to make it easier to locate the folder you are looking 
for.

Figure 2.16 When carrying out a 
filtered search such as via the Find 
panel, the Folders panel will now display 
a count value showing how many 
photos are selected out of how many 
total images in each folder.

Figure 2.15 The Find panel showing 
all the date search options.
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Metadata Browser panel options
In the Metadata Browser panel in the Library module (see Figure 2.17) 
there are now four new add categories: Aperture, Shutter Speed, 
ISO Speed Rating and Label. These additions are pretty self-evident 
in that they provide extra ways to filter the images that are displayed in 
the content area, although ‘Label’ is exactly the same as clicking on the 
one of the color label swatches in the Filters section of the Filmstrip.

In order to make the Metadata Browser panel more manageable you 
can use the Metadata section in the Catalog Settings (File ➯ Catalog 
settings…) to determine which items will be visible in this panel.

Figure 2.17 The Metadata Browser 
panel in which you can now filter photos 
according to new criteria such as ISO 
Speed Rating. 

Figure 2.18 The Metadata Catalog Settings.

page references
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Quick Develop panel
Now let’s look at the changes to the panels on the right of the 
Lightroom Library module interface, starting with Quick Develop. 
Figure 2.19 shows an expanded view of the Quick Develop controls 
showing the new look panel settings.

I think the new design is a lot clearer overall. The Quick Develop 
controls went through a number of different designs during the public 
beta and I always felt the buttons in the shipping version of Lightroom 
1.0 looked more like ‘placement icons’ than the real thing. The Saved 
Preset menu remains unchanged. Clicking on the disclosure triangle 
next to it reveals the Crop Ratio and Treatment menus. Again, the 
options here are the same as before, but the interface is in my view a 
lot clearer now, especially with regard to whether the image is in color 
or grayscale. It could be argued that you now need two mouse clicks 
rather than one to switch from color to grayscale. But to be honest, I 
think it is better to memorize the V shortcut as a means for toggling 
between color and grayscale mode and rely on the Treatment menu as 
more an ‘indicator’ of which mode a photo is in.

White Balance is clearer (rather than being labeled ‘WB’) and the 
Tone control section is neatly separated with the Auto Tone button 
at the top and the reset button relabelled Reset All, which makes it a 
lot clearer that clicking on it will reset all the develop settings that have 
been applied to a photo and not just those that have been applied via 
Quick Develop. As a result, use this button with caution. Down at the 
bottom a new Clarity develop adjustment has been added to Quick 
Develop. If you hold down the Option key (Mac), or Alt key (PC), the 
Clarity adjustment switches to say Sharpening and the Vibrance 
control below it switches to say Saturation. When you do this, the 
Sharpening control in Quick Develop allows you to adjust the amount 
of sharpening. All these new features – the Clarity adjustment and new 
sharpening controls – will be discussed in more detail in Chapter 3.

Figure 2.19 The Quick Develop panel.
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Keywording panel
Over in the Keywording panel (see Figure 2.20) the Keyword Tags 
section has a new menu next to it. The default view will show Enter 
Keywords. This can be used, as before, to enter new keywords and 
edit existing ones. Or, you can select the Keywords & Parents option to 
view the keywords only without editing them.

Keyword Sets behave the same as before. You can click on the 
Keyword Set menu to load one of the keyword presets that ship with 
Lightroom such as: Outdoor Photography, Portrait Photography or 
Wedding Photography.

Figure 2.20 The Keywording panel.
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if keywords are removed using an 

external program, the keywords will 

not appear removed when you view 

the photo in lightroom.
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Metadata panel

New view modes

The Metadata panel has two new view modes (see Figure 2.21). The 
Large Caption view mode displays a nice large Caption metadata 
field, offering you lots of room in which to write a text caption. In 
versions 1.0 the metadata fields expanded automatically anyway, but 
the large caption space here does at least make the Caption field easy 
to target. Click anywhere in this large field and you can start typing. 
Perhaps more usefully, hitting Enter or Return allows you to add a car-
riage return in this field section rather than committing the text.

The Location view mode offers a new alternative metadata view, 
perhaps more useful for reviewing travel photographs.

New Metadata panel interface

The other main difference with the new Metadata panel is that it now 
has lots of new action arrow buttons. To give you a clearer idea of 
what’s new here in the Metadata panel, in Figure 2.22 I have used the 
All Metadata view and highlighted the new items in yellow.

Figure 2.21 Here are the two new view modes for the Metadata panel: Large 
Caption (left) and Location (right).
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Figure 2.22 The  Metadata panel with all the new items highlighted in yellow.

note
Just when you think you have 

covered every angle, you find 

something else that’s new! ian 

lyons has written an article for 

computer-darkroom.com in which 

he explains how lightroom 1.1 can 

now read audio sidecar files that are 

associated with a captured image 

and list these in the metadata panel. 

if an audio sidecar file is present and 

you click on the action arrow next 

to the metadata item, lightroom 

will playback the audio file on your 

computer. For the full story, go to 

this link: www.computer-darkroom.

com/lr_11/lr-11-gps.htm.
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The Sidecar Files item shows up whenever there is a sidecar file 
associated with an image. These are always hidden from view when 
you inspect images in Lightroom and so this extra item in the Metadata 
panel let’s you know if an .xmp sidecar is present.

The Copy Name field is new to Lightroom 1.1 and refers to virtual 
copy images made in Lightroom. In the Figure 2.23 example you can 
see that the original DNG image has been highlighted and that three 
virtual copies have been made from the original master (you can tell 
they are virtual copies because they have a turned up page icon in the 
bottom left corner).

Each virtual copy image in Lightroom can be an alternative version 
of the original master (or negative as it is sometimes described in 
Lightroom). By making virtual copies you can try out different crops or 
color treatments. But since virtual copies all refer to the same master, 
they will all share the same file name. Now in Lightroom 1.1, whenever 
you create a new virtual copy, Lightroom will label each new virtual 
copy as: Copy 1, Copy 2 etc. But you’ll most likely want to edit this 
name. In the example above, I have renamed the Copy 2 photo (second 
one from the right) as ‘Grayscale’, which brings us to the Go to 
Master action arrow in the Metadata panel. If you have a virtual copy 
image selected in Lightroom you can locate the parent master photo 
by clicking on this button.

File Size is another new item. It displays a photo’s file size, showing 
how many megabytes it takes up on the disk.

Clicking on the action arrow next to the File Type metadata (Show 
photos with this file type) filters the photos in the Lightroom 
catalog to reveal all photos that are of the same file type. The 
same result can be achieved by going to the File Type section in the 
Metadata Browser panel and clicking on a file type in there.

Figure 2.23 Here is a view of a master photo with three virtual copies. The copy 
names will now be shown in the Metadata. 

page references
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Metadata change tracking

Earlier in this chapter on pages 398–399 you will remember me saying 
that Lightroom 1.1 has a new Save Metadata command – Command–S 
(Mac), Control–S (PC) – that allows you to save the metadata settings 
directly to the file. Normally, the Lightroom metadata setting edits are 
only saved to the central catalog file unless you have the ‘Automatically 
write changes into XMP’ option switched on in the File ➯ Catalog 
Settings dialog. So apart from that, the metadata settings will not 
update the photo files themselves unless you explicitly ask Lightroom to 
do so. That’s where the Save Metadata command comes in.

Figure 2.24 The Library View options.

In order to keep track of which files have been updated and which 
have not, Lightroom now offers a few visual clues. If you go to the 
View menu and open the Library View Options dialog (shown in 
Figure 2.24), there is a checkbox in the Cell Icons section called: 
Unsaved Metadata. When this is checked you will see a metadata 
status icon appear in the top right corner of the library grid cells (see 
Figure 2.25) which appears whenever there is what Lightroom calls 
a ‘metadata status conflict’. In other words, ‘you’ve updated the 
metadata for this photo and the metadata information embedded in 
the photo’s XMP space is now out of sync with the current Lightroom 
catalog file’. If the metadata written to a photo’s metadata is now 
out of date this isn’t really such a bad situation to be in. After all, the 
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metadata has been saved, it’s just that the metadata update is so far 
stored in the catalog file only (which you are backing up regularly, 
right?). The appearance of this icon is more of a reminder that should 
you wish to update the metadata to the file as well, it is now time to 
do so and Lightroom is highlighting for you the files that are in need of 
‘metadata saving’. Lightroom will even show an interim icon ( ) as it 
scans a photo, checking to see if the metadata is in need of an update.

Over in the Metadata panel there is a new item called Metadata 
Status, which will say ‘Has been changed’ if anything has been done 
to edit the photo metadata settings since the last time the metadata 
was saved back to the file. In other words, this tells you the same thing 
as the metadata status icon that can appear in the Library grid cells.

In each case, if you click on the icon in the grid cells or the button next 
to the Metadata status entry in the Metadata panel, this opens the 
dialog shown in Figure 2.26 that asks if you really want to save the 
metadata changes to disk or not. I think this is better described as ‘do 
you wish to confirm saving the metadata changes to the photo’s XMP 
space?’

Figure 2.25 When the Unsaved metadata icon is enabled in the Library View grid 
options the icon in the top right corner will indicate the metadata status has changed. 
A downward arrow indicates that Lightroom settings need to be saved to the file. An 
upward arrow indicates that settings have been edited externally and need to be read. 

Figure 2.26 This dialog will appear to confirm if you wish to save changes to disk.
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Labels, crop mode and ISO

Show photos with this label will filter the catalog images to reveal 
all those with color labels that match the selected photo. If a photo 
has been cropped in Lightroom, the Cropped item will appear in the 
Metadata panel (showing the crop dimensions in pixels). Click on the 
action arrow next to it to go directly to the Develop module in Crop 
mode. Show photos taken with this ISO will filter the catalog 
images to reveal all those with ISO settings that match the selected 
photo.

Date representation

Next to Date Time Original is the Go to Date action arrow. This will 
go to the Date section of the Metadata Browser panel and filter the 
catalog to show all photos with matching dates.

Figure 2.27 In the case of camera capture files that have not been converted to 
DNG, the Date Time Original, Date Time Digitized and Date Time entries will all agree. 

Figure 2.28 Where a camera capture image has been converted to DNG, the 
Date Time entry reflects the fact that the file was modified, resaving it in a different 
file format. In this case a raw file was converted to DNG a few days after the time of 
capture. 

Figure 2.30 And if you import a photo that was originally created as a new 
document in Photoshop or was originally a scanned image, only the Date Time field 
will be displayed showing the date that the file was first created. 

Figure 2.29 Similarly, if I was to create an Edit copy as a TIFF, PSD or JPEG version 
of the original, the Date Time will reflect that this version of the master image was 
created at a later date.

note
there are a few changes to the way 

file dates are handled and now 

displayed in the metadata panel. 

date time original means the date 

that a photo was captured or was 

first created.
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note
the date field action arrow no longer 

takes you to the edit capture time 

dialog. to access this you will need to 

choose edit capture time... from the 

metadata menu. 
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Mail and Web links

The E-Mail field now has an action arrow next to it. Another 
Lightroom user can send an email to the creator by simply clicking on 
the action arrow (see Figure 2.31).

Lightroom automatically creates a new mail message (as shown 
in Figure 2.32) via whatever mail program you are using on your 
computer. If the program is not currently running, Lightroom launches 
it automatically.

Similarly, if you click on the action arrow next to the Website field 
you’ll go directly to the creator’s chosen website link.

Figure 2.31 In this view of the Metadata panel you can see the action arrows next 
to the E-Mail and Website items. 

Figure 2.32 When you click on the E-Mail action arrow, this will automatically 
launch your default e-mail client program and compose a new email using the email 
address in the Metadata.
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Copyright status

The Copyright section also now has an action arrow next to the 
Copyright Info URL which when clicked takes you directly to the 
website. Above that there is also a Copyright Status field which is 
new to Lightroom 1.1 (but is already included in Bridge CS3), where 
you can set the copyright status as being Unknown, Copyrighted or 
Public Domain.

You can edit the copyright status via the Metadata panel, or you could 
go to the Metadata panel Presets menu to choose Edit Presets…  and 
create a new custom metadata preset via the Metadata Presets dialog 
shown in Figure 2.33. All images you apply this preset to (such as 
when importing) will be marked with the desired copyright status.

Figure 2.33 The Edit Metadata Presets dialog.

Editing Metadata presets
There is now an Edit Presets... option in the Metadata panel Preset 
menu list. When you select this you now have the option to modify an 
existing metadata preset and click Done to update the preset, or use 
the new Preset menu (see top section of the dialog shown in Figure 
2.33) and select Save Current Settings as New Preset... This neatly 
addresses what was a major shortcoming of version 1.0.

note
i should write a word or two here 

about what the term ‘copyrighted’ 

means. strictly speaking a 

‘copyrighted’ image is one that has 

been registered with the us library 

of congress, and this is a term that 

applies to the us only. so if you say 

an image has been ‘copyrighted’ 

it has an explicit meaning in the 

us that does not translate to mean 

the exact same thing to those 

photographers who operate outside 

of the us where us copyright laws 

do not apply. if you operate in the 

us and use this field to mark an 

image as being ‘copyrighted’, then 

you should be aware of the precise 

meaning of the term and get these 

images registered. if you choose 

to use the copyright field only 

to indicate this is your copyright, 

this statement should be clearly 

understood in nearly all countries 

and all that you need to enforce your 

rights ownership.
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Metadata panel data entry efficiency

One of the things that has always bugged me about Bridge is the way 
the metadata entry is engineered. Even in Bridge CS3, if you select an 
image, make the Description field active and enter new text, you have 
to press Enter to commit, select the next image, then re-target the 
Description field all over again to enter more text for the next image. 

So here is how it works. In Figure 2.34 you can see a library grid view 
of images taken at a model casting. I tend to shoot these castings with 
the camera tethered to the computer and update the Title field with 
each model’s name and model agency as I go along. In the screen shot 
shown here you can see that the Title field is currently active and I have 
typed in the model’s details. Instead of hitting Enter to commit this 
data entry, I can use the Command key (Mac), Control key (PC) plus a 
right or left arrow to progress to the next or previous image. This step 
will commit the text entry and progress to the next photo. It also keeps 
the metadata field active so that you are now ready to carry on typing 
in the information for the next photo.

note
it is said that lightroom 1.1 now 

makes the metadata entry more 

efficient and offers an easier way to 

update the metadata. But in actual 

fact i believe this ’new’ behavior has 

been there all along in version 1.0 

anyway. or maybe it is now more 

stable than it was before? Whatever 

the case i missed this feature first 

time around! 

Figure 2.34 If you use the Command key (Mac), Control key (PC) plus the left right 
arrow key to navigate between photos, highlighted fields in the Metadata panel will 
remain targeted and you are ready to edit the same metadata field for the next photo.
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Toolbar
There are a few small items worth noting in the toolbar, such as 
changes to the Compare view behavior, the new Painter tool and the 
sort ordering.

Figure 2.35 The new toolbar in interface for the Library module.

Figure 2.36 The new Compare view in Lightroom 1.1.

Compare view display

When using the Compare view mode (see Figure 2.36) to compare 
images side by side you can now choose to make the info overlay 
visible as well. To enable this, go to the Library module View menu 
➯ Loupe Info ➯ Show Info Overlay. Or use the Command–I (Mac), 
Control–I (PC) keyboard shortcut.

And if you have the Navigator panel open you can now use this to 
navigate the Compare view display. Use a single click in the Navigator 
preview to zoom in to whatever the close-up view zoom level is and 
then click or drag the zoomed-in rectangle to analyze different areas 
of the two images. And of course, you still have the lock button in 
the toolbar to unlock the zooming and scrolling for the two images 
in order to navigate each one separately. To return to the normal 
zoomed-out view, double-click anywhere inside the Navigator preview.
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Painter tool

The Painter tool replaces the previous Keyword Stamper tool. The 
Painter tool can be used the same way as the Keyword Stamper. You 
can use it as an easy way to repeat applying a keyword to images in 
the content area, except the Painter tool now allows you to go much 
further. You can read more on pages 393–395 about how this new 
feature works.

Sort functions

The Sort menu in the toolbar now resolves some of the possible 
contradictions in the way color labels are identified in Bridge and how 
they are identified in Lightroom. Instead of having a single sort option 
of sort by Color Labels, there are now two options: Sort by Label Text 
and sort by Label Color. And the reason for this is as follows:

1. In Lightroom 1.0 and 1.1, the default color label set uses the 
following text descriptions alongside each label: Red, Yellow, 
Green, Blue, Purple (to access the dialog shown here, go to the 
Library module Metadata menu and then go to the Color Label 
Set menu). OK, this is not a particularly imaginative approach, 
but the label text that is used here neatly matches the label text 
descriptions that were used in Bridge 1 (as included with the 
Creative Suite 2). Notice in the Lightroom 1.1 dialog shown here 
that it says: ‘If you wish to maintain compatibility with labels 
in Adobe Bridge, use the same names in both applications’. 
So far, so good. Lightroom 1.0 and 1.1 are both compatible with 
Bridge 1.0 when using the default settings in both programs.

page references
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2. However, in Bridge 2.0, as included with the Creative Suite 3, the 
text naming was changed to a new default setting. Shown here 
is how the default label text appears in the Bridge 2.0 program’s 
Labels preferences. If you install both new programs and use the 
default settings in each, the label text descriptions differ. This has 
led to problems such as white labels appearing in Bridge 2.0 where 
Bridge 2.0 cannot read Lightroom’s color label metadata correctly. 
In these specific instances, Bridge 2.0 can ‘see’ that a color label 
has been applied, but it does not know how to interpret the meta-
data correctly. Bridge 2.0 can read the color label text descriptions 
and display these in the Bridge Metadata File Properties section, 
but it does not read and apply the label color part.
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3. If you were to choose a color label set in Lightroom such as the 
Review Status set shown here, the problem will persist between 
Lightroom and  Bridge 2.0 because the descriptive terms used 
in both programs will be different. Furthermore, the Bridge 2.1 
update has not necessarily managed to resolve this conflict and the 
message remains the same. If you want to be absolutely consistent 
between applications when applying color labels, then make sure 
the label text matches.

If you edit a photo’s color label setting in Bridge and then in Lightroom 
using the Library module Metadata ➯ Read Metadata from File com-
mand, a similar conflict will occur. But instead of showing a white label, 
Lightroom will display no color labels in the grid or filmstrip views. If 
you go to the Metadata panel on the other hand, you will see the label 
text description that was applied in Bridge next to the Color Label item 
in the list. I would say that Lightroom handles the conflict situation bet-
ter, but how can you use the label criteria that was applied in Bridge 
and make use of it in Lightroom? Well this brings us neatly back to the 
Lightroom 1.1 update and why there are now two new sort options for 
color labels.

The sort by Label Color option allows you to sort photos by color 
labels that have been applied in Lightroom. The sort by Label Text 
option allows you to sort photos that have had text labels applied in 
Lightroom as well as letting you to sort photos where the labels have 
been applied via Bridge (because Lightroom is only able to read the 
label text part correctly).
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Sort order button

The sort order buttons shown in Figure 2.37 now make a lot more 
sense. Even though I have been using Lightroom on a daily basis I could 
still never work out the old stairs going up/going down icon! This 
new one makes it much easier to work out whether the sort order is 
ascending or descending.

Another useful feature is the way the sort order is now numerically 
sensitive. This means that Lightroom will reorder the follow-
ing number sequence correctly: 1,2,3,4,5,6,7,8,9,10,11,12,13… 
Previously, Lightroom would have reordered the numbers like this: 
1,10,11,12,13,2,3,4,5,6,7,8,9. I think most people probably did not even 
notice there was a problem here because they were using their camera 
or Lightroom to name their files and Lightroom would always rename 
using zeros to fill in the empty numbers before a number sequence. It 
was more often a problem where someone had perhaps made a whole 
lot of Edit copies and gone beyond –Edit10. Anyway, this is now no 
longer a problem.

Filmstrip

Rating filters

Nothing too much has changed here except to mention that the rating 
filter section interface is more obvious. Instead of little dots, we now 
have grayed out stars and this makes it easier to see that ‘this is where 
you click’ to activate the rating filters. The rating menu uses an icon 
button to represent whether the filtering rule is: Rating is greater than 
or equal to, Rating is less than or equal to or Rating is equal to. Again, 
this is more clearly worded than before and will hopefully make things 
easier for newcomers to understand.

Figure 2.37 The new Library module 
toolbar sort order buttons.

Figure 2.38 The new Filmstrip rating menu options.

page references
sorting images 105

Filmstrip filtering 76–79
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Breadcrumbs text

Look carefully at what is know as the ‘breadcrumbs text’ just above 
the filmstrip on the left and you will see the current library grid view 
Folders/Collections/Metadata Browser view showing the number 
of selected photos, the target photo file name and the number of 
selected photos will now be highlighted.

Figure 2.40 If you Option–click (Mac), Alt–click (PC) on a color label swatch in the 
filmstrip, you can now make inverted color label filter selections.

Figure 2.39 The breadcrumbs text will highlight the number of photos selected.

Color label filtering

page references
Filmstrip filtering 76–79

In the color label filter swatch section of the filmstrip you can now 
Option–click (Mac) or Alt–click (PC) on a color swatch to make an 
inverted color swatch selection. To be more precise, if you Option/
Alt click on a color swatch, this will select all photos that have a color 
label assigned except for that color. The inverted swatch selection will 
exclude photos that have no color label.

But remember, if you go to the File menu the Filters ➯ Filter by Color 
Label submenu includes options to filter photos by No Label, to select 
all those photos that have no label status. There is also an Other 
Label option that will allow you to filter photos that have a label status 
not completely recognized by Lightroom. In other words, choosing 
File ➯ Filters ➯ Filter by Color Label ➯ Other Label will allow you to 
filter photos that have had their color labels edited in Bridge but the 
label text descriptions are not currently synchronized with those used 
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Figure 2.41 The Filmstrip also includes filter Virtual Copy and filter by Master Copy 
buttons.

by Lightroom right now (see pages 416–418 for the reasons why 
Lightroom and Bridge sometimes have different ideas about what 
these color labels mean).

Modified filters and selections via the filmstrip

But that’s not all... you can also use the modifier keys to make more 
precise filter selections. Here is how it works. As before, you can click 
on a color swatch or star rating to filter images by color or star rating. 
If you hold down on the Shift key, you can add photos to the filter 
view in the grid view. So if you hold down Shift and click on the red 
and yellow swatch plus the one star filter rating, you can filter the view 
to show red and yellow labeled photos with one star only or one star 
and higher etc. And keep the Shift key held down to click on swatches 
or stars to remove them from the filter. Hold down the Command-click 
(Mac) or Control-click (PC) and click on a color or star rating (or a pick, 
or the Virtual copy filter), and instead of filtering the photos you can 
make a selection based on the buttons you click. Now hold down the 
Shift key as well as the Command/Control key and you can add more 
photos to the selection. And to remove photos from a selection, use: 
Command + Option (Mac), Control + Alt (PC). The key combinations 
used here should be very familiar, if you are used to using these modi-
fier keys when making Photoshop image selections.

Virtual copy and Master copy filters

Last of all we have the new Virtual Copy and Master Copy filter but-
tons. These can be used to filter the display to show or hide the virtual 
copy photos only and show or hide the master copy photos only.

page references
Virtual copies 80, 218
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photograph: Antarctica, © Jeff schewe 2005
Canon eos 1 ds mk ii | 160 mm | 100 iso | f5 @ 1/2500th 



Develop module3

If you thought that the Library module had a lot of new 

additions, just wait till you see what the Develop module has 

in store. The recent Adobe Camera Raw 4.1 update offered 

a few clues as to what you might expect to see in Lightroom 

1.1, things like the new sharpening and clarity adjustments. To 

borrow Russell Brown’s catchphrase ‘but wait, there’s more...!’, 

there is indeed more. We’ve got Match Exposure, hierarchical 

presets, camera-specific defaults, new tool overlays, plus new 

improvements to the Remove Spots and Remove Red Eye tools.
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Develop Menu

Exporting and importing presets

The Develop menu now looks rather slimmed down, which is because 
most of the menu items have now been moved over to the new 
Settings menu for the Develop module. But the first new item we have 
here is New Preset Folder… 

Figure 3.3 The Presets folder showing the newly created Black & White Presets folder.

Figure 3.1 The Develop menu.

Figure 3.2 The New Preset Folder dialog.

This menu item takes you to the new Folder dialog where you can cre-
ate a new Preset folder to be used for storing Develop module preset 
settings.
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If you take a look at the Presets panel in the Develop module after 
installing the 1.1 update, notice how presets are initially segregated 
into Lightroom Presets and User Presets. This folder separation offers 
the advantage of making it easier for you to manage lots of Develop 
presets and group them in ways that are more meaningful or easier 
to manage. In the Figure 3.3 example, I created a new folder called 
‘Black & White Presets’ to store all my black and white conversion 
settings. You can use preset folders to store groups of presets any way 
you like, although you can’t create subfolders of presets yet.

Figure 3.4 This view shows the contextual menu options for the Presets panel.

But what you can do is to use the contextual menu shown in Figure 
3.4 to access Export… or Import… develop settings. The contextual 
menu shown here can normally be accessed by right-mouse clicking on 
a folder inside the panel (although Macintosh users who are not using 
a two-button mouse will need to hold down the Control key and click 
with the mouse to see this menu). When you select either of these 
menu items, you will be taken directly to the Finder/Explorer browser 
window that points directly to the Lightroom Develop Presets folder.

This menu addition is great because it now makes it much easier for 
you to share develop presets settings with other Lightroom users. 
For starters you may wish to go to Richard Earney’s Inside-lightroom.
com website where you can access lots of different develop presets 
for Lightroom. No need to fuss about looking for the Develop Presets 
folder on the system. Just use the Import… command in this menu to 
locate and add these to the Presets panel in the Develop module.

page references
develop Presets 223–224
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Applying default develop settings
Any feature that saves you time, is always welcome. Very often you 
will find that as you import pictures from a particular camera shot at 
a certain ISO speed, you end up wanting to apply the same develop 
settings. For example, if you shoot with more than one digital camera 
you may want to create a custom camera calibration setting for each 
camera body. In addition you may want to adjust the noise reduction 
settings in the Detail panel to correct for the level of noise that is likely 
to occur at a specific ISO setting.

1.  One way you might use this feature would be to create a new 
folder called ‘Camera Presets’ and adjust the Develop settings for 
different ISO settings shot with that camera. Save these settings 
as new presets, checking just the items shown here (note that the 
New Develop Preset dialog now contains a Folder menu where you 
can select which folder to save a new preset to).

page references
saving a preset 224
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2. Go to the Lightroom Presets preferences and make sure that the 
Make defaults specific to camera serial number and Make 
defaults specific to camera ISO setting are both checked. It is 
important that you do this first before proceeding to the next step.

3. Now go to the Develop module and select a photo in the Filmstrip 
and match the Develop setting to the camera model, body serial 
number and ISO setting and apply the same matching Develop 
setting (as was saved in the previous step). Now go to the Develop 
menu and choose Set Default Settings… This will open the 
dialog shown here and all you need to do now is click the Update 
to Current Settings button. Do this and Lightroom will now 
automatically associate the setting you just chose prior to setting 
this option as the default setting for all newly imported photos 
that match the same criteria of matching the camera model, serial 
number and ISO setting. But remember that you have just set the 
default setting here. If you select a different type of setting to 
apply on import via the Import Photo dialog, then this will override 
the default settings applied here.
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Photo menu

Edit externally
The Edit in Adobe Photoshop and Edit in Other Application 
menu items will open the dialog shown in Figure 3.6, where the Edit 
items are listed in a different order. More importantly we now have 
Copy File Options, which is enabled when either the Edit a Copy 
with Lightroom Adjustments or the Edit a Copy option is selected. 
If you then click on the disclosure triangle to reveal the ‘Copy File’ 
options, you can adjust the File format, Color Space, Bit Depth and 
Compression options. If you refer to Chapter 4 of this PDF you can 
read how it is possible to configure the default copy file settings in the 
External Editing preferences. The Copy File options here simply allow 
you to override these default settings at the time a copy is being made.

Show folder location
Beneath the Show in Finder command we have Show in Folder in 
Library. This can be useful if you are working on an image in the 
Develop module that is part of a Collection and therefore likely to be 
referencing more than a single folder in the Library module Folders 
panel. You can therefore use this command to instantly locate which 
folder a photo belongs to. Select this menu item and you will be taken 
back to the Library module where the parent folder will be highlighted.

Figure 3.5 The Develop module Photo menu.

Figure 3.6 When you choose to edit 
a photo externally, there are now some 
new Copy File options.

page references
Virtual copies 218

edit in Photoshop 224–225
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Create Virtual Copy shortcut
The Create Virtual Copy feature was a late addition to Lightroom 
1.0 and has proven to be very popular, so much so that Create 
Virtual Copy now has its own keyboard shortcut: Command+’ (Mac), 
Control+’ (PC). I use this shortcut all the time now.

Saving Metadata
See page 398–399 for the low down on: ‘Save Metadata to File’, 
‘Read Metadata from File’ and ‘Update DNG Preview & Metadata’ 
commands.

Removing and deleting photos
To repeat what I wrote earlier on page 392 about removing and 
deleting photos, the photo deletion process did cause a certain amount 
of confusion in Lightroom 1.0 because some people were unclear 
about the distinction between deleting a photo to remove it from the 
Lightroom catalog and deleting a photo to not only remove it from the 
catalog but also remove it from the disk as well by sending it to the 
trash.

Now if you hit the delete key you will be faced with a slightly changed 
dialog that offers (as before) the option to simply remove the current 
photo(s) from the catalog, or the option to delete completely from 
the disk. Note here that selecting Delete from Disk… will remove 
the photos from the catalog and then send them to the system trash/
recycle bin. So although the warning message says that this process 
cannot be undone, it is not in fact a complete deletion. The photos 
you delete can still be accessed via the trash/recycle bin. It will only be 
when you choose to empty the trash/recycle bin that the images will 
truly be deleted forever.

If you are aware of this difference and wish to avoid having to go 
through the above dialog each time you hit delete to remove photos 
from the catalog, you can instead now use the Photo ➯ Remove 
Photos from Catalog command, or the Option + Delete (Mac), 
Alt + Delete (PC) shortcut. This allows you to remove photos from 
the catalog without showing the Delete photos dialog. Or use the 
Command+Option+Shift + Delete (Mac), Control+Alt+Shift + Delete 
(PC) shortcut to remove photos from the catalog and send them 
directly to the trash. Again, bypassing the Delete dialog.

Figure 3.7 The Delete Photos warning 
dialog.

page references
deleting photos 82



430 ChApTer 3 deVeloP module
This PDF was made available free of charge via: www.peachpit.com (not for resale)

Settings Menu
The Settings menu is new to the Develop module. But it is basically 
now a new menu location in which to contain many of the menu items 
that were previously located in the Develop module Develop menu.

Figure 3.8 The Develop module Settings menu.

Match Total Exposures
You can use this command to match the exposures across a series 
of images that have been selected via the Filmstrip. Match Total 
Exposures will calculate a match value by analyzing and combining 
the shutter speed, lens aperture, ISO speed the photos were captured 
at, plus any camera-set exposure compensation. It then factors in all 
these camera-set values, combine them with the desired exposure 
value (as set in the most selected image) and calculate new Lightroom 
exposure values for all the other selected images. I find that it can 
often be used to help average out the exposure brightness in a series 
of photos where the light values were going up and down during a 
shoot, while chief Lightroom architect Mark Hamburg also likes to 
describe this as a ‘de-bracketing command’. 

So in effect, if you highlight an individual image in the series and select 
‘Match Total Exposures’, the other images in that selection will auto 
balance to match the exposure of the target image. 
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1. In this example, the most selected photo in this filmstrip selection 
is too light in exposure, whereas the exposure in the photo to the 
left in the filmstrip is fine.

2. I selected the image to the left to make this the most selected image 
and then chose Match Total Exposures from the Develop module 
Settings menu. In this screen shot I reselected the original photo and 
you can see how the exposure setting is much improved and the 
exposure values for the other photos are also more even now.
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Swap Before and After settings
Lightroom users should already be familiar with the Before/After view 
modes available as previewing options via the Develop module toolbar.

1. In this example, I selected the Before/After Left/Right split option 
and you can see the original before version of the photo in the left 
half of the frame and the modified after version appear in the right 
half. 

Figure 3.9 The Before/After menu options.

With this view mode you have the option of previewing a selected 
image to see the before and after versions appear side by side.

page references
Before and after settings    208–211
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2. In Lightroom 1.1 you now have the facility to Swap Before and 
After Settings. If you use this menu command from the Settings 
menu, or use the keyboard shortcut: Command+Option+Shift+up 
arrow (Mac), Control+Alt+Shift+ up arrow (PC), you can switch the 
before and after settings. This is useful if you reach a point in the 
develop editing where you like the initial improvements you made 
and you then want to make further tweaks but wish to compare 
these with the current view. In a situation like this, you simply 
select the ‘Swap Before and After’ Settings command and then 
carry on editing the photo.

tip
You can load a snapshot or a History 

state into the Before view by right 

mouse-clicking (you can also 

control-click on macs) on the History 

state or snapshot in the panel list.  

this will pop a contextual menu 

allowing you to load the history state 

or snapshot to the Before view.
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View Menu

Progressive zooms
There are several ways that you can control the zoom settings in the 
Library and Develop modules. For example, if you go to the Navigator 
panel you can use the fly-out menu to set a custom zoom magnifica-
tion for the close-up loupe view. 

Figure 3.10 The Develop module View menu.

Figure 3.11 The Navigator panel zoom menu options.

Figure 3.12 There is also a zoom slider for the Develop module toolbar where you 
can use the slider to set the zoom level to the same zoom settings shown in Figure 
3.11.

If you make the Zoom slider option active in the toolbar you can use 
the slider shown in Figure 3.12 to adjust the zoom level at any time 
magnifying the photo using the same step values as shown in the 
Navigator panel.

page references
Zoom options 23, 69–70
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The new Zoom In Some and Zoom Out Some commands will allow 
you to zoom in or out using the same incremental steps as offered 
by the toolbar zoom slider. You can use Command+Shift+= (Mac), 
Control+Shift+= (PC) to zoom in and Command+Shift+minus (Mac), 
Control+Shift+minus (PC) to zoom out. These shortcuts will also work 
when operating in the Library module.

Tool Overlay menu
The Tool Overlay menu could do with a little explanation here as to 
how it works. These menu options only apply when you are working 
with the Crop tool, Remove Red Eye tool or Remove Spots tool. The 
tool overlays refer to the crop guides that appear inside a cropped 
area, the Remove Red Eye circles and the Remove Spots circles.

Figure 3.13 The Tool Overlay menu options.

The Auto Show mode only makes the tool overlays visible when the 
cursor is rolled over the content area. In other words, the crop guides, 
Remove Red Eye circles or Remove Spots circles will disappear from 
view when you roll the mouse cursor outside the image area such as 
up to the top panel menu.

In Figure 3.14 you can see how the Remove Spots tool circles are 
visible. Shown here is the area that is being healed (the circle with 
the thicker border) and the area that is being sampled from (the circle 
with the thinner border). We see these circles highlighted more clearly 
to emphasize which is currently the most active circle and the arrow 
reinforces the relationship between the two, indicating which is the 
source and which is the destination (for more about the new look 
spotting tools, refer to the spotting tools section on pages 447–456). 
Just below the active, highlighted circles you can see a circle indicating 
an area that has also been healed (the faint gray circle) where only the 
healed area is shown, because this circle is not currently active.
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If you select the Always Show menu option, the tool overlays 
behavior matches that found in Lightroom 1.0 in which they always 
remain visible. If you want to hide the tool overlays, select Never 
Show from the menu. When this menu option is selected the overlays 
remain hidden, even when you roll the mouse cursor over the image. 
But as soon as you start working with a tool, the tool overlay behavior 
automatically reverts to the Auto Show mode; and if you look at the 
Tool Overlay menu, you will see this option is highlighted.

Another way to work with this new tool overlay show/hide feature is 
to use the associated keyboard shortcut: Command+Shift–H (Mac), 
Control+Shift–H (PC) to toggle between showing and hiding the tool 
overlays. In practice, I find it simpler also to just use the H key to toggle 
between showing and hiding the tool overlays.

Later in this chapter we shall be looking at the Remove Spots Tool and 
Remove Red Eye tools in more detail.

Figure 3.14 Here is an example of the Remove Spots tool in use with the tool overlay 
visible.

page references
remove spots tool 212–213
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Crop Guide Overlays
The crop guide options have been extended in this 1.1 update so that 
you can choose from six different types of overlay in the Crop Guide 
Overlay menu.

Figure 3.15 The Crop Guide Overlay menu options

Figure 3.16 The Grid crop guide overlay.

I have listed all the different crop guide overlays below, starting with 
the Grid overlay. Note that regardless of whichever crop guide you 
choose, the grid always appears when you rotate the crop by dragging 
with the cursor outside the crop bounding box.

Grid

© Jeff Schewe

page references
cropping 130–134
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Thirds

Diagonal

© Jeff Schewe

© Jeff Schewe

Figure 3.17 The Thirds crop guide overlay.

Figure 3.18 The Diagonal crop guide overlay.
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Triangle

Golden Ratio

© Jeff Schewe

© Jeff Schewe

Figure 3.19 The Triangle crop guide overlay.

Figure 3.20 The Golden Ratio crop guide overlay.
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Golden Spiral

© Jeff Schewe

© Jeff Schewe

Figure 3.21 The Golden Spiral crop guide overlay.

Figure 3.22 You can use the Shift+O shortcut to switch the orientation of a crop.
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Crop guide orientation
It is worth pointing out that the O keyboard shortcut can be used to 
cycle through the crop guide overlays; use Shift+O to cycle through 
the crop guide orientation. In Figure 3.22 I have shown the Golden 
Spiral with a changed overlay orientation.

Cancelling a crop
You can now use the Escape key to revert to a previously applied 
setting made during a crop session. Let’s say that the picture shown 
in Figures 3.16–3.22 had been cropped slightly on the left. If you 
were to alter the crop by adjusting the crop ratio or crop angle and 
then hit the Escape key, you will always be taken back to the original 
crop setting. If, on the other hand, you adjusted the crop, exited the 
crop mode for this photo, started editing photos in another folder and 
returned later to this picture, the new crop setting will become the one 
that Lightroom reverted back to when you hit Escape. The crop cancel 
command is worked out on a per-session basis.

Figure 3.23 In case you haven’t noticed in the previous screen shots, the Develop 
module toolbar has a new crop lock icon. This icon is now colored. But the distinction 
between when the crop aspect ratio is locked and when it is unlocked is a lot more 
subtle than in the previous version of Lightroom. Notice also that the Aspect Ratio 
menu that is next to it is now more clearly labeled.
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Clarity slider
I believe Jeff Schewe campaigned hard to get this particular feature 
included into Adobe Camera Raw, and here it is now in Lightroom 1.1. 
As Jeff himself will tell you, Clarity is a hybrid based on two separate 
contrast enhancing techniques. One is a local contrast enhancement 
technique, devised by Thomas Knoll, using a low amount and high 
radius setting in the Photoshop Unsharp Mask filter. The other is a mid-
tone contrast enhancement Photoshop technique that was originally 
devised by Mac Holbert of Nash Editions. Those who have bought my 
most recent book, Adobe Photoshop CS3 for Photographers, can 
read there the steps Mac used in Photoshop to create this effect. The 
Photoshop instructions are admittedly quite complex. However, Clarity 
is now available as a simple one shot slider control in the Basic panel of 
the Develop module.

1. Here is a screen shot showing a close-up 1:1 view of a photograph 
taken of some pumpkins. A few adjustments have been made to 
the basic tone controls and sharpening has already been added 
via the Detail panel. You don’t have to necessarily be viewing the 
image at 1:1 in order to evaluate the results, but it is usually the 
best way to work.
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2. In this next screen shot you can see how the pumpkins looked 
after adjusting the Clarity slider. In this example I have taken the 
slider to the maximum setting in order to show the most dramatic 
difference between the two. Normally, you would want to start 
around ‘10’ and try not to overdo the effect. But as you can see, 
the Clarity adjustment adds a halo edge effect to the midtones 
only (the shadows and highlights are protected). As you increase 
the amount, the halos get wider, strengthening the midtone 
contrast effect and making the midtone areas look sharper. You 
can see the halos forming as you drag the slider left and right.

The Clarity adjustment is one that can usefully be applied to a great 
many kinds of photographs. Mac Holbert originally devised this particu-
lar effect in order to boost the midtone contrast and he found that it 
helped him to bring out crisper detail in his landscape prints. But I think 
most photographs can gain from having a little bit of clarity added. 

tip
i usually aim to add a clarity value 

of about 10 and no more than that. 

However, a number of lightroom 

users have been complaining about 

the limited output sharpening in 

lightroom. so you might want to 

consider giving certain photographs 

a clarity boost just prior to printing. 

the way i suggest you do this is to 

create a virtual copy of the master 

photo and mark this as a ‘print only’ 

copy (using the copy name field in 

the library module metadata panel) 

and increase the clarity amount 

more significantly. try doing some 

experiments for yourself and see if it 

improves the look of your prints. 
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White Balance tool
White balance in Lightroom 1.1 has a few new features, plus one that 
was in the beta and then left out of the shipping version: namely, the 
ability to make persistent white balance adjustments. Here is a step-by-
step guide to working with the new white balance tool.

1. Click on the White Balance tool to undock it. The tool allows 
you to take a white balance measurement from anywhere on the 
photo.

page references
White Balance 139–141, 146
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2. To make a white balance adjustment, select an area of the picture 
that should be neutral in color, but not a bright white area of the 
photo. The light gray stones are a perfect place to sample from. 
If the Auto Dismiss box in the toolbar is checked, the White 
Balance tool will automatically return to its docked position in the 
Basic panel. If you uncheck the Auto Dismiss box in the toolbar, 
you are able to click and keep clicking with the White Balance tool 
until you are satisfied with the white balance adjustments that you 
have made.
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3. The Show Loupe checkbox allows you to toggle displaying the 
loupe that appears just below the White Balance tool cursor. You 
can now adjust the loupe scale setting by dragging the slider 
next to the Show Loupe item in the toolbar. This slider adjusts 
the sample grid pixel size, and dragging the slider to the right 
will increase the number of pixels used to sample a white balance 
point measurement.
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Spotting tools

Remove Spots tool
The Remove Spots tool and Remove Red Eye tools have both undergone 
a makeover in the interface design and the way these tools are used. 
The Remove Spots tool has now done away with the red and green 
colored circles where red represented the source circle and green the 
sample circle. White circles with a thin circle represent the source and a 
thicker circle represents the sample area. In Figure 3.24 I have illustrated 
several of the ways you can work with the Remove Spots tool. Some of 
the behavioral changes are quite subtle. On the next page is a list of the 
ways you can work with the Remove Spots tool.

Click with the remove spots 
tool to create a new spot circle 
and auto select a sample point.

Click the reset button to 
cancel and start over again.

Click and drag outwards to create  
the relationship shown here between 
the source (thin) and sample (thicker) 
circles.

roll the mouse to activate a 
remove spot source circle 
and drag the circle edge to 
adjust the spot size.

marquee drag , holding 
down the # key (Mac) 
or c (PC) to define the 
spot size and auto select 
the source point.

Cllick on the source circle 
and drag to reposition 
the circle.

mouse-down on the 
sample circle and drag to 
reposition the circle.

© Jeff Schewe

Figure 3.24 This figure shows a combined series of snapshots taken of the Remove 
Spots tool in action to illustrate the different ways you can use this tool.

page references
remove spots tool 212–213
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Clone or Heal

The options here are the same as they were previously. In Clone mode, 
the Remove Spots tool copies pixels using a feathered circle edge. 
In Heal mode the Remove Spots tool copies pixels and blends them 
around the inner edge of the circle. You can also use the Clone/Heal 
buttons in the toolbar to switch the spotting mode for a Remove Spots 
circle. Another important thing to be aware of with the Heal mode 
is that if you click with the Remove Spots tool in Heal mode, rather 
than drag to set the sample point, the Remove Spots tool behaves 
like the spot healing brush in Photoshop. That is to say, Lightroom will 
automatically select the best point to sample from. This behavior is 
well worth noting when using the Synchronize Settings (see below) to 
synchronize your spotting work. I’ll be coming on to this shortly.

Spot Size

This used to be called ‘Cursor Size’, but it’s still pretty clear that you 
can adjust the size of the Remove Spot cursor circle by adjusting the 
slider. You can do this before you apply the tool or you can use the 
slider to readjust the size of a selected circle. You can also use the 
square bracket keys to adjust the spot size of the cursor before you use 
it to create a new spot. Use the left bracket ([) to make the spot size 
smaller and the right bracket (]) to make the spot size bigger.

Click and drag

Place the Remove Spots cursor over the area you want to remove and 
center the cursor using the cross hair. Hold down the mouse and drag 
outwards to set the source circle position. As you do this, the area 
inside the source circle is updated as you drag to set the position of the 
sample circle.

Click only

Just click with the Remove Spots tool to remove a mark or blemish. 
In this respect you could say that the Remove Spots tool is able to 
work a bit like the spot healing brush that is found in Photoshop and 
Photoshop Elements. When you click with the Remove Spot tool in 
Lightroom, it automatically places the sample circle for you and use 
a certain amount of built-in intelligence to choose a suitable point to 
sample from.
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Editing the spot circles

As before, the Remove Spots circles remain fully editable. You can click 
on a sample circle and drag to move the sample area. But now you 
can only resize the spot size by dragging the slider in the toolbar or by 
holding the mouse down on the edge of a source circle only and drag-
ging. Note, too, when you drag on a source circle to resize it, that the 
thin circle cursor will conveniently disappear, allowing you so see more 
clearly the effect these changes are having on the photo. Similarly, if 
you hold the mouse down inside a spot circle, the thin circle will disap-
pear and change to show the hand icon and allow you to drag and 
reposition the source spot circle.

Hiding the spot circles

The most convenient way to hide the spot circles and inspect a photo 
without them overlaying the image is to use the H keyboard shortcut. 
Pressing H will always hide the spot circles, but as soon as you com-
mence work with the Remove Spots tool, all the spot circles will be 
revealed again.

Undoing/deleting spot circles

Use Command–Z (Mac), Control–Z (PC) to undo the last spot circle. To 
delete an individual spot circle, click to select it and hit the Delete key. 
And to remove all spot circles from an image, click the Reset button in 
the toolbar.
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Synchronized spotting
You can quite easily synchronize the spotting work done to a single 
photo in Lightroom with other photos. All you have to do is to make a 
selection of images via the Filmstrip. Make sure the photo that has had 
all the spotting work done to it, is the one that is the most selected or 
‘target’ photo and then click on the Sync… button (see Figure 3.25). 
This opens the Synchronize Settings dialog shown in Figure 3.26. If 
you click the Check None button, check the Spot Removal checkbox 
and then click the Synchronize button, Lightroom will synchronize the 
spot removal settings across all the selected images. 

tip
 if you have made a selection of 

images via the Filmstrip (or in the 

library Grid view) you can also 

use the command+shift–S (mac), 

control+shift–S (Pc) shortcut to 

open the synchronize settings 

dialog.

Heal mode synchronization

As I mentioned previously, if you click with the Remove Spots tool 
in Heal mode instead of dragging, Lightroom automatically chooses 
the best area of the photo to sample from. As long as you don’t try 
to edit the sample point (by manually dragging the sample circle to 
reposition it), the spot circle will remain in its ‘auto-select sample point’ 
mode. If you therefore carry out a series of spot removals using only 
the Heal mode and always click with the tool rather than drag, you 
can synchronize the spot removal more efficiently. If you synchronize a 
series of photos in this way, the Lightroom spot circles will auto-select 
the best sample points in each of the individual synchronized photos. 
This does not guarantee 100% successful spot removal synchronization 
across every image, but if you follow this advice your spot removal 
synchronization results will generally be more successful.

Figure 3.26 The Synchronize Settings dialog with Spot Removal checked only.

Figure 3.25 If two or more photos are 
selected in the Filmstrip, you can use the 
Sync button to synchronize the develop 
settings from the most selected (target) 
image and the other selected photos. 
The target image shown here is the one 
with the lighter gray border.
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Synchronized spotting with Adobe Camera Raw

Many of the new features found in the Lightroom 1.1 Develop module 
are there because they are also part of the Adobe Camera Raw 4.1 
update. If you happen to be using Photoshop CS3 with this latest 
version of Camera Raw, you can synchronize the spot removal as you 
apply it! Make a selection of images in Bridge and open them up via 
Camera Raw (as shown in Figure 3.27). Now click on the Select All 
button. This will select all the photos and if you now use the Retouch 
tool (that’s what it is called in Camera Raw) to remove spots from the 
most selected photo (the one shown in the main preview), the spotting 
work will automatically get updated to all the other selected images. 
This is quite a cool new feature in Camera Raw, but alas, there is no 
mechanism in Lightroom that will allow you to achieve the same thing 
in the Develop module! 

Figure 3.27 The Adobe Camera Raw 4.1 dialog that is available for Adobe 
Photoshop CS3 and Bridge 2.0.

page references
synchronize settings   125, 220–221
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Remove Red Eye tool
Before the 1.1 update, the Lightroom cursor was in the shape of a 
cross; You marquee dragged with the cursor to define the area you 
wanted to treat and Lightroom calculated where to apply the red eye 
correction within that area. What you ended up with was a rectangle 
overlay that would shrink to fit around the pupil and automatically 
correct the red eye.

The new Lightroom 1.1 Remove Red Eye tool cursor is shown here in 
Figure 3.28. And as you can see, it now looks a lot different. The way 
you use the tool is to target the center of the pupil using the cross hair 
in the middle and drag outwards to draw an ellipse that defines the 
area you wish to correct. You don’t have to be particularly accurate. 
In fact it is quite interesting to watch how this tool works when you 
lazily drag to include an area that is a lot bigger than the area you 
define with the Remove Red Eye tool cursor. It is quite magical the 
way Lightroom knows precisely which area to correct. The cursor will 
shrink to create an ellipse overlay representing the area that has been 
targeted for the red eye correction.

Figure 3.28 The new Remove Red Eye tool cursor design.

page references
remove red eye tool 214
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1. Here is an example of the Remove Red Eye tool in action. In this 
screen shot you can see that I selected the remove Red Eye tool 
from the tool bar and dragged the cursor over the left eye moving 
from the center of the pupil outwards. Alternatively, I could simply 
have clicked on the pupil using the Remove Red Eye tool.
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2. After I released the mouse, a Remove Red Eye tool ellipse overlay 
shrank to fit the area around the eye. As I just mentioned, you 
don’t really have to be particularly accurate with the way you 
define the eye pupils. In this screen shot you can see that I applied 
a red eye correction to the eye on the right. Notice here how the 
first ellipse overlay has a thinner border and the current ellipse 
overlay is thicker, indicating that this one is active. When a red eye 
ellipse is active you can then use the two sliders in the toolbar to 
adjust the Remove Red Eye settings. Use the Pupil Size slider to 
adjust the size up or down for the area that is being corrected. 
Next to this is the Darken slider that you can use to fine-tune the 
appearance of the pupil. I tend to find that the Lightroom auto-
correction (using the midway settings of ‘50’) is usually spot on in 
most instances.

 

tip
You can adjust the size of the cursor 

by using the square bracket keys. use 

the left bracket ([) to make the cursor 

size smaller and the right bracket (]) 

to make the cursor size bigger. to 

be honest, the cursor size doesn’t 

always make much difference 

because big or small, once you click 

with the tool you can drag the cursor 

to define the area you wish to affect. 

the cursor size is probably more 

relevant if you are using the red eye 

tool to click on the pupils to correct 

them rather than dragging. But as i 

say, the tool always seems to do such 

a great job anyway of locating the 

area that needs to be corrected!
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3. As before with the Remove Spots tool, when an ellipse overlay is 
active you can hit the Delete key to remove an individual ellipse 
overlay. However, if you move the mouse over to the edge of the 
ellipse and drag to resize the area or drag from inside to reposition 
the ellipse, the behavior is quite different. If you drag the overlay 
edge to resize the Remove Red Eye overlay, it does not recalculate 
the red eye adjustment, but it allows you to fine-tune the shape 
and size of the red eye adjustment. You know how it is said by the 
Lightroom engineers that there are no layers in Lightroom? Well, 
this is so far the first example of what you could call a Lightroom 
layer. The benefit of this is that you can really get the red eye 
correction coverage to match the eye pupil precisely.
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4. All will become even clearer if you hold down the mouse over the 
center of the pupil and drag the ellipse overlay outwards. Basically 
the ability to resize the shape of the red eye correction and reposi-
tion it allows a much greater degree of red eye control than you 
could previously in Lightroom.
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Color panel
Over in the Color panel (see Figure 3.29) you can use either the Shift 
key or you can use the Command key (Mac), Control key (PC), to click 
on the individual color swatches to choose which specific color slider 
controls you want to have visible. Previously you could only click to see 
one set of color sliders at a time or click on the All button to have all of 
them visible at once. This new refinement allows you to economize on 
screen real estate.

Figure 3.29 The Color panel allows you to use the Shift key or the Command key 
(Mac), Control key (PC) to select multiple color swatches. This new feature will allow 
you to adjust the panel view so that only the color sliders you need to work with are 
visible.

page references
color panel 168–171
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Lens Corrections panel
The Lens Correction panel features two new automatic defringe 
controls. The first one is called Highlight Edges and it is able to cor-
rect for the color fringing that you sometimes see in extreme burnt-out 
highlight areas. This type of color fringing is caused by extreme light 
exposure hitting the camera sensors, which can overload individual 
photosites with too many photons. This in turn creates problems in the 
demosaicing process. The Highlight Edges Defringe option is therefore 
carrying out a different kind of calculation in order to correct the 
magenta fringing that is sometimes seen around the highlight edges. 
I have to say that the effect is really subtle and it has not been easy to 
find a photograph where one can show a significant amount of differ-
ence between the before and after, but Figure 3.30 shows a picture 
taken of sunlight reflecting off the sea, that is a typical example of the 
sort of shot that could benefit from a Highlight Edges correction.

Figure 3.30 The Highlight Edges Defringe command can be used to auto correct 
color fringing in the extreme highlights.

page references
lens corrections panel      176–179
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All Edges corrections

The All Edges correction also offers a rather subtle auto correction, 
but I do find that it can be useful if you need to improve an image with 
chromatic aberration that is proving tricky to remove using the manual 
sliders in the Lens Corrections panel.

1. Here is a photograph where you can see really bad chromatic 
aberration at the edges of the frame.
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2. This image required quite a bit of manual correction and in this 
example I set the Red/Cyan slider to –19 and the Blue/Yellow slider 
to +32. This seemed to be the optimum setting to use, but there 
was still a little bit of fringing around the high contrast edges that I 
could not get rid of completely.
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3. In this last example I selected the All Edges Defringe option. The 
difference between this and the previous screen shot may appear 
quite subtle on the screen, but when you compare the before and 
after by toggling the effect in Lightroom you should be able to see 
a distinct improvement. I therefore like to look upon the All Edges 
defringe setting as a way to polish up the edges and remove the 
chromatic aberration that the slider settings on their own can’t 
manage.
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Reset Develop settings
The Reset button will reset the Develop settings to whatever default 
user settings you might have already set in Lightroom. Just to recap, I 
explained earlier on page 427 how you could now create user default 
settings in Lightroom and that you could use the Lightroom Presets 
preferences to make default settings specific to the camera body serial 
number and ISO setting. So if you click on the Reset button, Lightroom 
will use whatever default setting you have created and reset the 
Develop settings to this.

Set Default…

How do you create a default setting? Well, you could select a specific 
photo, go to the Develop menu and choose Set Default Settings... 
That will create a new default setting in Lightroom and if you have the 
above preferences set to make the setting specific to the camera body 
and ISO type, the default setting you create will be specific to that 
combination of camera and ISO setting.

Or alternatively, you can hold down the Option key (Mac), Alt key 
(PC) and the Reset button in the Develop module will change to Set 
Default… Whichever method you use, the dialog shown below in 
Figure 3.31 will appear, asking you to confirm that you want to go 
ahead and set this setting as a new default.

Figure 3.31 If you hold down the Option key (Mac) or Alt key (PC), the Reset button 
will change to say ‘Set Default...’ When you click on this button it will pop the dialog 
shown here. It is important to heed the warning here, that clicking ‘Update to Current 
Settings’ will permanently update the default settings used in Lightroom.

page references
reset develop settings 220
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Reset (Adobe)

And finally, if you hold down the Shift key, the Reset button will 
change to say: Reset (Adobe). Clicking on the button in this mode, 
overrides the Lightroom user default settings and resets the Develop 
settings to the standard Adobe Lightroom default values.

Figure 3.32 If you hold down the Shift key the Reset button will change to say ‘Reset 
(Adobe)’. Clicking this button will reset a photo to the normal Adobe Lightroom default 
values.
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Sharpening and noise reduction

Capture sharpening for a sharp start
Before discussing the new sharpening controls in Lightroom 1.1, I 
should briefly explain the principle behind capture sharpening and the 
difference between this and output sharpening.

The Unsharp Mask filter in Photoshop has been around since the very 
earliest days of the program and has not really changed much since 
then. As Photoshop has matured our understanding of sharpening and 
how to best use the Unsharp Mask filter controls has improved and 
various techniques have evolved that cleverly use the Unsharp Mask 
filter to its best advantage. In his lifetime, author and Photoshop guru 
Bruce Fraser, did the industry a great service with his research into 
Photoshop sharpening. His recipes for optimum sharpening based on 
whether you were sharpening for input, i.e. ‘capture sharpening’, or 
sharpening for output, have done a lot to improve our understanding 
of how to apply the most appropriate level of sharpening at each step 
of the image editing and printing process. It is also fair to say that 
Bruce’s research and writing had an impact on the way some of the 
sharpening controls in Lightroom evolved. But more of this later.

Capture sharpening is all about adding sufficient sharpening to a 
photograph in order to correct for the inherent lack of sharpness that 
most digital images suffer from to a greater or lesser extent. If you 
shoot using raw mode, then your photographs will arrive untreated 
in Lightroom and they will most definitely need some degree of 
sharpening. If the photos you import have originated from a digital 
camera shot using the JPEG mode, then they will already have 
been sharpened in-camera. The Detail panel sharpening controls in 
Lightroom are therefore intended for use with photographs that are 
raw originals or non-raw files that have not been sharpened yet.

The main goal with input/capture sharpening is to correct for the lack 
of sharpness in an image. Capture sharpening is therefore something 
that you can evaluate on the monitor (providing you use the 1:1 view 
setting) and it is all about making the photograph look just sharp 
enough on the screen. You don’t want to over-sharpen at this stage, 
since that can lead to all sorts of problems later at the retouching stage 
in Photoshop.

page references
removing noise     172–174
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Output sharpening is something that is always done at the end, just 
prior to making a print, and if you are familiar with the Lightroom 
Print module, you are aware of the sharpening options available there. 
But note that Lightroom does not allow you to see on the screen the 
effect of output sharpening. The print sharpen processing is hidden 
from view and the only way to evaluate print output sharpening is by 
judging the print. But I am getting ahead of myself here. This section is 
all about the capture sharpening and what’s new and special about the 
sharpening controls in Lightroom 1.1.

Sharpen preset settings
Perhaps the easiest way to get started is to use either of the two new 
Sharpen presets found in the Develop module Presets panel shown in 
Figure 3.33 (Develop presets are also available via the Library module 
Quick Develop panel). These two presets can be a useful starting point 
when learning how to sharpen in Lightroom 1.1. All you have to do is 
decide which of these two settings is most applicable to the image you 
are about to sharpen.

Figure 3.33 The Presets panel in the Develop module contains two new sharpening 
preset settings. When you click to select one of these it will modify the Detail panel 
settings only.
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Sharpen – Portraits

As you read the rest of this section it will become apparent what the 
individual sliders do and which combination of settings will work best 
with some photographs and not others. But to start with let’s look 
at the two preset settings found in the Lightroom Presets subfolder. 
Figure 3.34 shows a 1:1 close-up view of a male portrait where 
naturally enough I chose to apply the Sharpen – Portraits preset. 
This combination of sharpening slider settings is the most appropriate 
to use for portraits male or female, or any photo where you wish to 
sharpen the important areas of detail such as the eyes and lips, but 
protect the smooth areas (like the skin) from being sharpened.

Figure 3.34 Here is an example of the Sharpen – Portraits preset in action.
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Sharpen – Landscapes

The other preset setting you can chose is Sharpen – Landscapes. 
This combination of sharpening slider settings is most appropriate for 
subjects that contain a lot of edge detail. You could include quite a 
wide range of subject types in this category. In Figure 3.35 I used 
the Sharpen – Landscapes preset to sharpen an architectural scene. 
Basically you would use this particular preset whenever you needed to 
sharpen photographs that contained a lot of fine edges.

Getting to know what the sharpening sliders do

These two preset settings provide you with a great way to get started, 
make the most of the new sharpening settings and get improved 
sharpening without having to understand too much about how the 
sharpening in Lightroom 1.1 works or what the individual sliders do.

Figure 3.35 Here is an example of the Sharpen – Landscape preset in action.
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Sample sharpening image
To help explain how the individual sliders work, I have prepared a test 
image that has been carefully designed to try and show some of the 
key aspects of Lightroom 1.1 sharpening. You can access this image by 
going to Lightroom-News.com and downloading it from the feature 
story on Lightroom 1.1 sharpening.

The image shown below in Figure 3.36 was specially designed to 
demonstrate several key aspects of Lightroom sharpening. The eye and 
surrounding skin texture allows you to see the effects of portrait style 
sharpening where the objective is to sharpen detail like the eyelashes, 
but avoid sharpening the skin texture. Conversely, the patchy texture 
in the bottom right corner allows you to test the ability to sharpen 
smooth texture content where you do want to emphasize the texture 
detail. The high contrast detail content in the left hand section allows 
you to test the effects of sharpening on fine-detailed image content. 
And the crisscross lines have been added so as to highlight the effects 
of the Radius setting.

Figure 3.36 The sample image used in the final section of this chapter can be accessed 
via the following link: http://photoshopnews.com/stories/images/sharpen-test.jpg
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Evaluate at a 1:1 view
But first things first. When you go to the Detail panel shown in Figure 
3.37 to access the Sharpening slider controls, a warning triangle will 
appear if the photo you have selected is displayed at anything less than 
a 1:1 view. If you magnify the image view to 1:1 or higher, the triangle 
will disappear. Or, you might just want to click on the triangle itself 
– this acts as a direct route to a 1:1 view. In any case, the grayscale 
previews I’ll be discussing shortly won’t work unless you are viewing 
the image at 1:1 or higher.

Luminance targeted sharpening
The first thing to say about Lightroom sharpening is that the sharpen-
ing is only applied to the luminance information in a photograph. 
Lightroom always filters out the color content when it applies the 
sharpening. This is a good thing because sharpening the color informa-
tion enhances any color artifacts and it is the luminance content that 
we really want to sharpen here. In the early days of Photoshop, people 
sometimes converted an RGB image to Lab mode and sharpen the 
Luminosity channel separately. This technique allowed you to sharpen 
the luminance information without sharpening the color content. 
More recently (from Photoshop 3.0 onwards), it has been easier (and 
less destructive) to sharpen in RGB mode and use the Luminosity 
blend mode to restrict the sharpening to the luminance information. 
Lightroom does a similar thing here: it filters out the color content 
when sharpening. For this reason it can be useful to inspect the image 
in luminance mode when working with the slider. You can do this by 
holding down the Option key (Mac), Alt key (PC) as you drag on the 
Amount sharpening sliders in the Detail panel. In addition to this you 
can hold down the same Option/Alt key to isolate the effect the other 
slider controls are having.

The sharpening effect sliders
Let’s start by looking at the sharpening effect controls: Amount and 
Radius. These two sliders control the how much sharpening is applied 
and how the sharpening is distributed. As I mentioned earlier, you 
can download this image and import it into Lightroom and copy the 
steps described here. Note that all these screen shots were taken while 
holding down the Option key (Mac), Alt key (PC) as I dragged on the 
slider controls.

Figure 3.37 The warning triangle 
in the Detail panel will indicate that 
the image is currently being viewed 
at a lower than 1:1 view. Click on the 
triangle to jump to a 1:1 view.
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Amount slider

1. The Amount slider is like a volume control. The more you apply, 
the more you sharpen the image. In this respect it works in a 
similar way to the Amount slider in the Unsharp Mask filter. The 
Amount range can go from zero (no sharpening) to 150 (maximum 
sharpening, where the slider scale goes into the red). The 150 
setting goes well beyond the 0–100 range that was available 
previously, but there is a reason for this: you can use the sharpen 
suppression controls (described a little later) to dampen the effect 
of the sharpening. Although you are rarely going to need to set 
the sharpening as high as 150, the extra headroom is available 
should you need it. In this above example you can see what the 
image looks like using the default 25 sharpening.
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2. As I increase the Amount sharpening to 100 you can see how all 
the detail in the image looks crisper. But used like this, the Amount 
slider is a fairly blunt instrument and it is the newly included ability 
to modify the distribution of the sharpening and filter out the edge 
halos that makes Lightroom 1.1 sharpening so special.
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Radius slider

1. For this step and the next I held down the Option key (Mac), Alt 
key (PC) to isolate the effect that the Radius setting would have on 
the image. At the minimum Radius setting you can see that a small 
radius will have the greatest effect on the narrow edge detail such 
as the fence wire in the picture and very little effect on the soft 
edge detail such as the eye. Notice also the effect the small radius 
has on the crisscross lines.
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2. When I take the Radius slider to the maximum setting notice how 
the halo width increases to the point where the halos have less real 
sharpening effect on the fine edge detail. The sharpening around 
the wire fence area looks kind of fuzzy, but at the wider setting 
there is more noticeable sharpening around the eyelashes of the 
eye and the eye pupil.
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The suppression controls
The next two sharpening sliders act as dampening controls that modify 
the effect the Amount and Radius sharpening settings have on an 

image.

Detail slider

The Detail slider cleverly suppresses the halos effect and thereby allows 
you to concentrate sharpening on the edge areas. This in turn allows you 
to apply more sharpening with the Amount slider, adding sharpness to the 
edges, but without generating noticeable halos around them. A setting of 
zero will apply the most halo suppression and a setting of 100 will apply 
the least halo suppression.

1. In this step the Detail slider has been set to zero. I am holding down 
the Option/Alt key to preview the effect this slider setting adjustment 
is having in isolation. When the Detail slider is at this lowest setting 
nearly all of edge halos will be suppressed. The combination of a low 
Detail setting and a medium to high Radius setting will allow you to 
apply a strong sharpening effect to bring out details like the eye and 
eyelashes while suppressing the halos on the smooth skin tones.
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2. When the Detail slider is raised to the maximum setting, all of the 
sharpening effect is allowed to filter through, unconstrained by 
the effect ‘Detail’ would otherwise have on the sharpening effect. 
When Detail is set to 100, you could say that the Amount and 
Radius sharpening settings are allowed to process the image with 
almost the same effect as the Unsharp Mask filter in Photoshop.
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3. When the Detail slider is set to a midpoint value between these 
two extremes, we see how the Detail slider can be used to target 
the areas that need sharpening most. If you refer back to the 
sharpen preset used at the beginning, a lower setting of 20 is suit-
able for portrait sharpening because it will suppress the sharpening 
more so the smooth tone areas. A higher Detail setting will carry 
out less halo edge suppression and is therefore more suitable for 
emphasizing fine edge detail.
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Interpreting the grayscale sharpening preview

This would be a good point for me to explain what the grayscale pre-
views are actually showing us here. As I have already stated, if you hold 
down the Option/Alt key as you drag on the Amount slider, you see an 
accurate preview of the cumulative effect that all the sharpening sliders 
are having on the Luminosity information in an image. But when you 
Option/Alt drag on the Radius and Detail sliders you are seeing a rather 
different kind of preview, because with these you are able to preview 
the sharpening effect in isolation.

What does this mean? The more experienced Photoshop users will per-
haps understand better if I explain that this is a little (but not exactly) 
like previewing a duplicate layer of the Background layer after you 
have just applied the High Pass filter. There is a Photoshop sharpening 
technique where you apply the High Pass filter to a duplicate of the 
Background layer to pick out the edge detail and set the duplicate 
blend layer to Overlay mode. The High Pass filter will turn most of 
the image a mid gray. When you set the layer to the Overlay blend 
mode, the mid gray areas will have no effect on the appearance of the 
photograph, while the lighter and darker areas in the layer will build 
up the edge contrast. The Radius and Detail Option/Alt mode previews 
are basically showing you the edge enhancement effect as if it were an 
isolated sharpening layer. And what these previews are showing you is 
the combination of the Amount, Radius and Detail slider settings in an 
isolated preview.

Masking slider

The Masking slider adjustment adds a final level of suppression control 
and was inspired by Bruce Fraser’s written work on his Photoshop 
sharpening techniques. If you want to read more about Bruce’s tech-
niques for input and output sharpening plus his creative sharpening 
techniques, I highly recommend you check out Real World image 
sharpening with Adobe Photoshop CS2 (it is still just as valid if you 
are working with CS3). The basic concept of the masking control is 
that you use this slider to create a mask that is based on the image 
content that protects the areas you don’t want to have sharpened.

If you take the Masking slider all the way down to zero, no mask 
will be generated and the sharpening effect will be applied without 
any masking. As you increase the Masking setting more areas will be 
protected. The mask is generated based on the image content such 
that areas of the picture where there are high contrast edges will 

note
i should also point out that the 

option/alt mode previews for the 

masking slider shows a mask that 

limits the sharpening adjustment. 

the best way to interpret this 

preview is to imagine the preview 

of the sharpening adjustments as 

being like a sharpening layer above 

the image and think of the masking 

preview as a layer mask that has 

been applied to that imaginary 

sharpening layer.
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remain white (the sharpening effect is unmasked) and the flatter areas 
of the picture where there is smoother tone detail will turn black (the 
sharpening effect is masked). The image processing required to process 
the mask is quite intensive, so if you are using an older computer 
it may seem slow as the preview takes its time to update. But on a 
modern, fast computer you will hardly notice any time delay.

1. In this example, I set the Masking slider to 50 and held down 
the Option/Alt key to reveal the mask preview. Again, always 
remember that the Option/Alt previews will only work if the image 
is viewed at 1:1 or higher. At this midway setting you will notice 
how the flatter areas of the picture are just beginning to get some 
mask protection such as the skin tone areas around the eye.
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2. As the Masking setting is increased to the maximum of 100 you 
can see how more of the flatter tone areas are now protected 
while the high contrast edges are preserved. At this extreme 
setting, Lightroom sharpening only applies to the areas shown in 
white. The black portions of the mask are completely protected 
and no sharpening will be applied in these areas.
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Applying manual sharpening adjustments
Now that I have given you a run down on what the individual sharpen-
ing sliders do, let’s look at how you would use them in practice to 
sharpen an image.

1. In this first example I adjusted the Sharpening sliders to provide the 
optimum amount of sharpening for the fine detail areas. I applied 
a Radius of 0.7 to add small halos around the edge details and a 
Detail of 70 in order to limit the halo suppression. And I applied 
an Amount of 45 to make the fine edge detail nice and crisp. The 
Masking slider was set to zero, which meant that no mask was 
used to mask the sharpening effect.
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2. In this second example I adjusted the Sharpening sliders to provide 
the optimum amount of sharpening for the soft edged detail 
around the eye. I applied a Radius of 1.5 to build wider halo edges 
around the eyelashes, but at the same time I used a Detail setting 
of 20 to suppress the edge halos. The Radius setting still has an 
effect on the sharpening, but the Detail slider is nicely suppressing 
the halo edge effect to produce a smoother looking sharpening 
effect. The Masking slider was taken all the way up to 85, so that 
I could target the sharpening on the areas that needed sharpening 
most, i.e. the details in the eye and eyelashes. You will note 
that the Amount was set to 33. This is a higher value than the 
previous default of 25, but this is because the sharpening is being 
substantially suppressed by the Detail and Masking sliders, so it is 
therefore necessary to apply a larger Amount setting.
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Noise reduction
The noise reduction in Lightroom has undergone some improvements 
in this latest update. It may be hard to see what these changes are 
exactly, but if you compare the slider setting adjustments in Lightroom 
1.1 with those in Lightroom 1.0 side by side in close up, you can 
definitely see quite a difference.

As with the Sharpening controls, you can only evaluate the effect 
of the noise reduction sliders by viewing the image at a 1:1 view or 
higher. In Figure 3.38 I have shown two versions of a close-up detail 
of a photograph that was shot using the Canon EOS 400D at an ISO 
setting of 1600. The left half of the content area shows the Noise 
Reduction in Lightroom 1.0 using a Luminance noise reduction of 
33 and a Color noise reduction of 33. The right half of the content 
area shows how the close-up section will look when those exact same 
settings are applied in Lightroom 1.1.

Figure 3.38 This close-up view shows a comparison between the old style Noise 
reduction in Lightroom 1.0 (left) and the new improved noise reduction in Lightroom 
1.1 (right). Both versions were captured using the same noise reduction settings.

page references
removing noise     173, 175
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When you compare the settings side there is a distinct improvement 
in the way Lightroom 1.1 handles the luminance and color noise. In 
particular you can see how Lightroom 1.1 does a much better job of 
reducing the white speckles in the shadows. The noise reduction in 
Lightroom 1.1 may not be as spectacular as Noise Ninja or Noiseware. 
But it is now considerably more effective than it was before.
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photograph: salmon point, mendocino, CA, © martin evening 2007
Canon eos 1 ds mk ii | 54 mm | 400 iso | f13 @ 1/250th 



Lightroom preferences4

So much has been changed in the way that the Lightroom pref-

erences have been laid out and added to, that it seemed best to 

offer a complete guide to configuring the preference options, 

including those items that are new to Lightroom 1.1.
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General preferences

Let’s begin with the startup options. If you deselect Show splash 
screen during startup, you can disable the Lightroom screen from 
showing. This is just a cosmetic thing really and it depends on whether 
you want to have the screen shown in Figure 4.2 displayed or not as 
the program loads.

page references
General Preferences 13, 314

Figure 4.1 The Lightroom 1.1 General preferences.

Figure 4.2 The Lightroom startup splash screen.
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Incidentally, there is a splash screen Easter egg in Lightroom. If you 
go to the Lightroom menu and choose About Adobe Photoshop 
Lightroom… you will be shown the startup splash screen as usual. If 
you then hit the R key you will see the alternate splash screen shown in 
Figure 4.3 (that’s R as in “Arrr”). There are also a few extra variations 
of the screen that you can access. Try using Command+Option–R 
(Mac), Control+Alt–R (PC) and also Command+Shift–R (Mac), 
Control+Shift–R (PC) and see what happens!

Once you let the pirates on board, be warned that some things in 
Lightroom may never be the same again! Figure 4.4 shows how the 
Rename photo dialog will look after switching to pirate mode. And 
take a close look at the Library module toolbar, do you see anything 
different? Hint: check out the Filmstrip options screen shot towards the 
end of this chapter.

When you first installed Lightroom you would have had the option 
to choose whether to be notified automatically of any updates to 
the program. In case you missed checking this, you can check the 
Automatically check for updates option.

Figure 4.3 The alternative, pirate splash screen.

Figure 4.4 The Rename Photo dialog shown in ‘Pirate’ mode.
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Catalog selection

In the Default Catalog section you can select which catalog should be 
used each time you launch Lightroom (such as ‘Load the most recent’). 
Note that the ‘Choose’ button is gone. This is because what used to be 
known as a library file is now defined in Lightroom as being a ‘catalog 
file’. If you refer back to the General menus chapter, you can read on 
page 354 about how you can create new catalogs via the File menu in 
Lightroom 1.1. 

Also missing from here is the ‘Automatically back up library’ option, 
which has now been moved to the Catalog Settings. These are located 
separately in the File menu, but you can also jump directly to the 
Catalog Settings by clicking on the Go to Catalog Settings button 
at the bottom of the General preferences dialog. And from there 
you can use the backup section to decide at which times you wish 
to backup the Lightroom catalog. For more information about the 
Catalog Settings and working with catalogs in Lightroom, please refer 
to Chapter 1 on the General Menus items.

Completion sounds and prompts

Next are the Completion Sound options where you can select to have 
an alert play after completing an import or export from Lightroom. You 
will often see warning dialogs with a “Don’t show again” check box at 
the bottom of the dialog. If you click the “Reset all warning dialogs” 
button, you restore all the default warning alerts.
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Presets preferences

Figure 4.5 The Lightroom 1.1 Presets preferences.

Default Develop Settings

If you are familiar with the controls found in Develop and Quick 
Develop then you will know there is an Auto Tone button that can be 
used to apply a quick auto adjustment to a photo, automatically adjust-
ing the Exposure, Blacks, Brightness and Contrast to produce what 
Lightroom thinks would be the best combination. Checking Apply 
auto tone adjustments will turn this feature on as a default setting.

After this we have Apply auto grayscale mix when converting to 
grayscale. I reckon you might as well leave this on because Lightroom 
auto grayscale conversions usually offer a good starting point. Auto 
grayscale is linked to the Temp and Tint slider settings in the Basic 
panel White Balance section. If you adjust these and then click on the 
Grayscale button, you will see how the Grayscale Mix settings adjust 
automatically.

note
auto tone can often produce quite 

decent auto adjustments and may 

at least provide an oK starting point 

for newly imported photos. But 

on the other hand, it may produce 

uglier looking results. experience 

seems to suggest that photographs 

shot of general subjects – such as 

landscapes, portraits and most 

photographs shot using the camera 

auto exposure settings –  will often 

look improved when using auto 

tone. subjects shot under controlled 

lighting conditions, such as still lifes 

and studio portraits, can often look 

worse when using auto tone. it really 

depends on the type of photography 

that you do as to whether selecting 

Apply auto tone adjustments 

would be a useful setting to have 

checked or not. i suggest leaving it 

unchecked.

page references
develop presets 223–224
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Camera-linked settings

The next two items in the Default Develop Settings section are linked 
to a new feature found in the Develop module Develop menu called 
‘Set Default Settings…’ which I discussed earlier on pages 426–427. 
Basically, if you check Make defaults specific to cameras serial 
number and Make defaults specific to camera ISO setting, you 
can use these preference checkboxes to determine whether certain 
default settings can be made camera-specific and/or ISO-specific.

The Reset all default Develop settings button allows you to revert 
all the develop settings to their original defaults.

Restoring presets

At the bottom in the Presets section we have reset buttons that can be 
used to restore various Lightroom settings. Restore Export presets 
will restore the preset list used in the File ➯ Export dialog.

Figure 4.6 The Keywording panel, showing the Keyword Set section.

Reset Keyword Set Presets

Over in the Library module Keywording panel (see Figure 4.6), you 
will notice that Lightroom provides a few Keyword Set templates that 
can be used for keywording photos. The default sets include: Outdoor 
Photography, Portrait Photography and Wedding Photography (see 
Figure 4.7).

Each set contains nine custom keywords and if you mouse down on 
the Keyword Set menu in the Keywording panel (or choose Metadata 
➯ Keyword Set ➯ Edit…) you can customize these default keyword 
sets. In the Lightroom Presets preferences click on Restore Keyword 
Set Presets to restore the keyword sets in their original form.
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Restore Filename Templates

The Restore Filename Templates button reverts the default file 
rename templates used in the Filename Template Editor (see Figure 
4.8). This will not affect any of the custom templates you have added 
here, it will merely reset the settings for the default templates that you 
have edited.

Restore Text templates

The same thing applies with the Restore Text Templates button that 
restores the default settings in the text Template Editor, as used in the 
Slideshow and Web modules.

Figure 4.8 These templates can be reset to their default presets. On the left, the 
Filename Template Editor and on the right, the Text Template Editor.

Figure 4.7 The Edit Keyword Set dialog.

page references
Keywording panel 90–97

Keyword sets 95–96

text template editor  270–272, 294–296 

Filename template editor 51
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Exporting presets

Now that we have the ability to export photos as a catalog, you 
can check the Store presets with catalog option if you would like 
Lightroom to export the custom presets you created and used as part 
of an exported catalog. This is useful if you are migrating library images 
from one computer to another because it will save you having to 
transfer your custom settings separately (such as your develop settings)
or if you wish to share your custom settings with other users. But then 
again, maybe you would prefer not to give away your own custom 
settings. This preference item gives you that choice.

Figure 4.9 The Lightroom 1.1 Presets preferences.
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Import preferences

Figure 4.10 The Lightroom 1.1 Import preferences.

Figure 4.10 shows the Import preferences. The top two items were 
previously in the File Management preferences section. There is now 
a simple checkbox for Show Import dialog when a memory card 
is detected. When this item is checked, this will force the Import 
dialog to appear automatically whenever you insert a camera card into 
the computer. The Ignore camera-generated folder names when 
naming folders option can help fast track the import process if you 
wish to import everything directly from a camera card into a single 
Lightroom folder. For example, maybe you have a camera card with 
photos that were shot using more than one camera and they have 
ended up in several different folders. When this option is checked, all 
the card folder contents will get grouped into one folder.

Some photographers like using their camera’s ability to capture and 
store JPEG file versions alongside the raw capture files. However, prior 
to the Lightroom 1.1 update, Lightroom would treat the JPEG captured 
versions as if they were sidecar files. But if the Treat JPEG files next 
to raw file as separate photos option is left checked, Lightroom will 
now respect these as being separate files that must be imported into 
the Lightroom catalog along with the raw versions. In addition to this, 
Lightroom 1.1 should no longer treat any non-JPEG files that can be 
imported as being sidecar files.

page references
import preferences 14
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DNG options

At last, we have DNG file options! So many photographers who archive 
their images using the DNG file format have been asking for this. In the 
Import DNG Creation section you can now configure the DNG settings 
for when you import photos as DNG. But note that the settings shown 
in Figure 4.10 will only apply to the ‘importing’ of files as DNG. If you 
choose Library ➯ Convert Photo to DNG (see Figure 4.11) you will see 
the exact same options as are found in the Lightroom Import prefer-
ences. And if you choose the DNG file format in the Export dialog, you 
will again be given access to these DNG file options. So let’s now take 
a look at these in more detail.

We first have the File Extension, which can use lowercase ‘dng’ 
or uppercase ‘DNG’, whichever you prefer. Next, the JPEG Preview 
that can be: None, Medium Size or Full Size. If you really want to trim 
the file size down then you could choose not to embed a preview, 
knowing that a new preview will always be generated later when the 
DNG file is managed elsewhere. You might select this option if you 
figure there is no value in including the current preview. A medium size 
preview will economize on the file size and this would be suitable for 
standard library browsing. After all, most of the photos in your catalog 
will probably only have medium sized previews. But if you want the 
embedded previews (and remember these are the previews embedded 
in the file and not the Lightroom catalog previews) to always be acces-
sible at full resolution and you don’t consider the resulting increased 
file size to be a burden, then choose the Full Size preview option. This 
will have the added benefit that should you want to view these DNGs 
in other applications such as iView Media Pro, you will be able to 
preview the DNGs at full resolution using a preview that was generated 
by Lightroom. This means that photos processed in Lightroom as DNGs 

Figure 4.11 The Convert Photo to DNG dialog shares the same settings options as 
those listed in the Import preferences.

page references
dnG file format 9, 39, 49
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should then preview exactly the same when they are viewed in other 
applications.

For the Image Conversion Method you have two options. You can 
choose Preserve Raw Image, which will preserve the raw capture 
data in its original ‘mosaic’ format, or you can choose Convert to 
Linear image, which will carry out a raw conversion to demosaic (con-
vert) the original raw data to a linear image – what Lightroom is doing 
anyway when converting the raw image data to its internal RGB space. 
Except if you do this as part of a DNG conversion you will end up with 
huge DNG file sizes. This is also a one-way process. If you convert a 
raw file to a linear image DNG, you won’t be able to take the raw 
data back to its original mosaic state again and you won’t be able to 
reconvert the raw data a second time. So why bother? In nearly every 
case you will want to preserve the raw image. But there are a few 
known instances where DNG compatible programs are unable to read 
anything but a linear DNG file from certain cameras. Even so, I would 
be wary of converting to linear for the reasons I have just mentioned.

The Compressed (lossless) option is checked by default. This is 
because the compression method the DNG file format uses compresses 
the file size without incurring any data loss. And by this I mean there 
will be no loss of image data, no loss of metadata or any other secret 
source data embedded in the original proprietary raw file. DNG 
compression may result in a file that is slightly smaller than the original. 
That’s because the DNG compression method is often better than that 
used by the camera manufacturers. You can also reverse this process 
quite easily (and without incurring any loss) by re-saving a DNG file 
with this compressed option turned off.

Embed Original Raw File embeds a copy of the original proprietary 
raw file inside the DNG file. This option allows you to preserve the 
original raw file data within the DNG file format but with the possibility 
to reverse the process in order to access the original raw file format. 
The penalty is increased file size, since you will be storing two versions 
of the raw file data in a single file. One argument in favor of doing 
this is that by preserving the raw file in its original file format, you can 
access the original file format and process it in the proprietary raw 
processing program. For example, the new Canon 400D camera allows 
the proprietary CR2 rawfiles it produces to store dust-spotting data 
that can only be written or read using Canon software. If you don’t 
embed the original raw file, you lose the means to process your photos 
using the camera manufacturer’s software. 

tip
Personally i have no trouble convert-

ing everything i shoot to dnG and 

never bother to embed the original 

raw data with my dnGs. i do however 

sometimes keep backup copies of 

the original raw files as an extra 

insurance policy. But in practice i 

have never had cause to use these.

tip
Generating full size previews in a 

dnG file can also allow you to make 

high quality prints via other pro-

grams outside of lightroom using 

the lightroom rendered settings.
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External Editing preferences

Figure 4.12 The Lightroom 1.1 External Editing preferences.

This is the one set of preference controls where there hasn’t been 
much change. The Lightroom External Editing preferences will let 
you customize the pixel image editing settings for Photoshop plus 
one other external, pixel editing program (such as Adobe Photoshop 
Elements or Corel Paint Shop Pro). Here you can establish the File 
Format, Color Space, Bit Depth and where applicable, Compression 
settings that are used whenever you ask Lightroom to create an Edit 
copy of a library image to work on in an external pixel editing program. 
You can use the Edit in Photoshop section to establish the default file 
editing settings when choosing Command–E (Mac), Control–E (PC) to 
edit a selected photo in Photoshop. In this example The TIFF format is 
used with a ProPhoto RGB color space, 16-bits per channel bit depth 
and ZIP compression. And below this you can specify the default set-
tings to use when editing photos in an Additional External Editing 
application. For example, if you had Photoshop Elements installed 
on your computer you might want to use the settings shown here to 
create edit versions as TIFF files in 8-bit per channel using the sRGB 
color space.

page references
external editors  14

Filename template editor 51
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And at the bottom we have the new Edit Externally File Naming sec-
tion. Previously, Lightroom would always append each externally edited 
image with –Edit at the end of the filename. And as you created 
further edit copies, Lightroom would serialize these: –Edit1, –Edit2 
etc. In Lightroom 1.1 you can customize the file naming.

In the Figure 4.13 example, you could create a custom template that 
adds a date stamp after the original filename.

Figure 4.13 The Filename Template Editor
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File Handling preferences

Figure 4.14 The Lightroom 1.1 File Handling preferences.

If only there could be agreement on common standards for the way 
metadata information is handled between different programs. Adobe’s 
open-source XMP specification has certainly gone a long way toward 
providing the industry with a versatile standard format for storing 
metadata information, but there are still a few gotchas that can pre-
vent the smooth integration of informational data from one program 
to another. The Reading Metadata section in the File Handling 
preferences (see Figure 4.14) is there to help try and solve such incon-
sistencies. If you check Treat ‘.’ As a keyword separator and Treat 
‘/’ as a keyword separator, this enables Lightroom to better interpret 
the keyword hierarchy conventions used in other programs.

File names that contain illegal characters can also cause hiccups 
when you import such files into Lightroom. The Treat the following 
characters as illegal characters item can be set to recognise ‘/:’ as 
an illegal character, or alternatively, you can select the extended list of 
characters (the one selected in the above screen shot) to encompass 
more potential bad characters that would need to be replaced. In the 
Replace illegal file name characters with section you can then 
choose a suitable replacement character to use such as a dash (-), an 
underscore (_) or similar characters. 

tip
some database and FtP systems 

may prefer spaces to be removed 

from file names. For example, when i 

upload files to my publisher, the FtP 

server they use will not allow such 

files to be uploaded. this is where 

the When a file name has a space 

item can come in useful, because 

you can choose to substitute a space, 

with a dash (-) or an underscore (_) 

character.
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Interface preferences

Figure 4.15 The Lightroom 1.1 Interface preferences.

Figure 4.16 You can use the contextual menu to quickly access the full range of 
panel end mark options.

Panel end marks

Where there were once just two panel end marks we now have a total 
of 13 to choose from. You can see the Panel End Mark menu options 
in the Panels section of the Interface preferences in Figure 4.15 and 
Figure 4.16 below.

page references
interface   17
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You can select a panel end mark via the Lightroom Interface Panels 
preferences, or you can use the contextual menu in the Library module 
to access them quickly. Just right-click on the end of the panels list and 
navigate to the Panel End Mark submenu and select the desired panel 
end mark.

I have compiled here a visual reference guide (see Figure 4.17) that 
shows all the different panel marks you can now choose from and of 
course you can also choose ‘None’ if you don’t want to see any kind of 
panel mark appearing in the Lightroom modules.

Figure 4.17 This shows all the panel end marks now available in Lightroom 1.1.
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Custom panel end marks

Do you fancy creating your own panel end mark design? Well, it’s quite 
easy to do. Take a screen shot of one of the current panel end marks 
to get an idea of the scale of the design and how it will look against 
the panel background color. Create a new custom design in Photoshop 
scaled to the correct size and on a transparent layer. Save this graphic 
using the PNG file format (which can support transparency). Now go to 
the Panel End Mark menu and select: Go to Panel End Marks Folder. 
This will reveal the folder in the system finder. Place the PNG file you 
have just created in there and then reopen the Lightroom preferences. 
You will now see your custom design listed in the Panel End Mark 
menu!

If you want to change the panel font size, go to the Panel Font Size 
section and select Small or Large Size. However, this change will not 
take effect until after you have relaunched Lightroom.

Lights Out

The Lightroom Interface preferences let you customize the appearance 
of the interface when using the Lights Out and Lights Dim mode. Bear 
in mind here that these preference settings also allow you to create a 
‘Lights up’ setting. So instead of using black as the Lights Out color, 
you could try setting this to light gray or white even.

Background 

The Background section will let you customize the background appear-
ance when viewing an image in Loupe mode. You can adjust the fill 
color or choose to add a pinstripes texture pattern.

page references
lights out mode  24

Background appearance 17
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New Filmstrip preference options

In the Filmstrip section you have, as before, the Show ratings and 
picks in filmstrip option, but in addition you can choose Show 
badges in filmstrip and Show tooltips in filmstrip. Examples of 
all these are shown in Figure 4.18 below. There is also a new Show 
photos in navigator on mouse-over option. All of these combine 
to make information about the catalog and catalog navigation a lot 
more flexible. With all these items checked you will have fuller access 
to Library module functions while working in other modules. For 
example, let’s say you are working in the Develop module. You can 
use the Filmstrip to see at a glance all the current filtered images, with 
their labels, ratings and pick status. You can use the mouse to hover 
over individual images to see a slightly larger preview in the Navigator 
panel and the tooltip floating window can be used to quickly reveal 
the filename, time of capture and pixel dimensions. The badge icons 
indicate whether keyword metadata has been added or the Develop 
settings have been edited. Clicking on a Metadata badge immediately 
takes you to the Keywording panel in the Library module, highlighting 
the keywords so they are ready to edit. Clicking on the Develop edit 
badge takes you back to the Develop module again where you can 
resume editing the develop settings. These filmstrip options extend the 
usefulness of the filmstrip as a way to manage the Lightroom catalog 
photos.

Figure 4.18 The Lightroom 1.1 Filmstrip interface showing most of all the new 
Filmstrip extra view options.
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Interface Tweaks

These last two items were also in the previous Interface preferences 
dialog. When Zoom clicked point to center is checked, the loupe 
view uses the click point as the center for its magnified view. To 
understand how this works, try clicking on the corner of a photo in 
the standard loupe view. If ‘Zoom clicked point to center’ is checked, 
the corner will zoom in to become centered on the screen. When 
this option is unchecked the photo will zoom in with the corner point 
positioned beneath the mouse cursor. Personally, I find that deselecting 
this option offers a more logical and useful zoom behavior.

The Use typographic fractions option offers a fine-tuning tweak to 
the Lightroom interface and the way the shutter speeds are presented 
within the Metadata panel in the Library module. In the example 
shown in Figure 4.19 the fractions option was left unchecked in the 
left version and on the right the shutter speed is represented when 
typographic fractions are used.

Figure 4.19 The left hand view of the Metadata panel shows the shutter speed 
displayed when Use typographic fractions is switched off. And the right hand panel 
view shows the shutter speed displayed when Use typographic fractions is switched 
on.
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photograph: oslo harbour, © martin evening 2006
Canon eos 400 d | 14 mm | 800 iso | f5 @ 1/60th 



Lightroom 1.1 extras5

We’re not quite done yet. There are still a few more innovations 

in Lightroom 1.1 that should get a mention. Namely, what’s 

new in the Slideshow, Print and Web modules. For this final 

chapter I have grouped these new features all together into a 

single chapter.
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Slideshow module
The Slideshow module has undergone a minor menu change (see 
Figure 5.1 below), offering more playback options. There has also 
been a revision of the slideshow display mechanism, which means that 
you should see smoother transitions when playing slideshows.

Play menu

page references
slideshow module 262–279

Figure 5.1 The Slideshow module Play menu.

The most noticeable change here is the addition of a Play menu. This 
contains a few menu items that were previously listed in the Slideshow 
menu and the new items are those highlighted here in yellow. For 
example, we have: Go to Next Slide and Go to Previous Slide. 
These aren’t new features, just new to the Play menu in Lightroom 1.1. 
Note the keyboard shortcut shown here that uses the Command key 
(Mac) or Control key (PC) plus the left or right arrow keys to progress 
through the slides. You can also use the arrow keys on their own to 
navigate the Filmstrip. But the use of the Command/Control key plus 
arrow will preserve any selection of images that is active. 
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Figure 5.2 The Slideshow module Play ➯ Which Photos submenu.

Figure 5.3 The Slideshow toolbar, where I have highlighted the Preview play button.

Slideshows and selections
The Slideshow module now has the ability to respect selections made 
in the Library grid view or Filmstrip when playing photos in a slideshow 
(providing there is more than one image selected). This depends on 
the option selected in the Which Photos submenu (see Figure 5.2). 
If the Use Selected Photos option is checked, the Slideshow module 
plays only the selected images. If Use All Available Photos is selected 
you will get the original behavior in Lightroom where the slideshow 
plays all the photos in the current Grid/Filmstrip starting starting from 
whichever is the most selected or target image.

When you want to preview a Slideshow you can, as before, use the 
Preview button (see Figure 5.3) in the Slideshow toolbar to play 
backthe slideshow in the Content area. But you can now go to Play ➯ 
Preview Slideshow to do the same thing, or use the Option+Return 
(Mac), Alt+Return (PC) keyboard shortcut.

To force Lightroom to run a slideshow using all photos, us: Play ➯ Run 
Slideshow with All Photos or the Shift+Return keyboard shortcut. 
This means you can keep ‘Use Selected Photos’ in the Which Photos 
submenu selected so that the default Lightroom behavior is always to 
respect selections (which I think most people will prefer) and use the 
Shift+Return shortcut whenever you want to override this default and 
run a slideshow that plays all photos instead.
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Print module

Print overlays
If you go to the Layout panel in the Print module you will notice a new 
item called Image Print Sizes in the Show Guides section at the bottom. 
When this is checked, Lightroom displays the dimensions of a photo 
above each cell using the ruler units selected at the top of the Layout 
panel. This overlay won’t be seen in the final print.

Using the native pixel resolution for print

If you uncheck Print Resolution in the Print Job panel (see Figure 
5.5), Lightroom will output an image at its native pixel resolution 
without resampling the image data to fit a set pixel resolution. This 
could be useful if you wanted to output a print file from Lightroom 
as a PDF without resampling the pixel data. Do this and you can save 
out a full pixel size master print file from Lightroom. Note, however, 
that the image’s native resolution must fit within the range of 72–480 
pixels per inch.

Figure 5.4 This view of the Print module shows an example of a contact sheet 
template with the Image Print Sizes overlay enabled. You can see the print size for 
each image displayed in the top left corner of each cell.

Figure 5.5 The Print Job panel 
showing the checkbox that you can 
uncheck if you want to turn off the Print 
resolution resampling.

page references
Print module  230 –259 

Print overlays     240–243 

Print Job panel         246, 251, 253, 256
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Web module

Web module and selections
The Web module also has the potential to respect an active selection 
of one or more images. It all depends on the Which Photos submenu 
that is shown in the Web menu above. If Use Selected Photos is 
checked, Lightroom will build a web gallery based on the selected pho-
tos only. If Use All Available Photos is checked, you will return to the 
original behavior in Lightroom where all the photos in the current Grid/
Filmstrip will be used to generate a new Web gallery. In the screen shot 
below in Figure 5.7, you can see an example of a Web gallery that has 
been generated from a selection of photos via the Filmstrip.

Figure 5.6 The Web module Web menu.

Figure 5.7 If Use Selected Photos is checked, Web galleries can be based on a 
Filmstrip selection when more than one image is selected.

page references
Web module 280–303

note
the lightroom team recently 

announced that airtight interactive 

have released three new Flash-based 

gallery templates for lightroom. You 

can find out more about these new 

templates and how to download 

them by going to: blogs.adobe.

com/lightroomjournal/2007/06/

airtight_interactive_web_galle.html.
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Web templates
The Web menu also includes an item called New Template and 
another called New Template Folder. A template is basically the same 
as a preset (which was the menu term used in version 1.0). As with the 
Develop module you can now place your templates in folder groupings.

New Web module panel layouts
The panels that run down the right hand side have either been 
renamed or reorganized slightly, so the remaining panel changes are 
mainly cosmetic. Most of the functionality is the same, though, and 
since the Web module features are all described thoroughly in the 
book, I have chosen not to go into too much detail about what all the 
controls do.

I should mention that the panels featured here are all associated with 
the HTML Gallery style (which is where you will see the most new 
changes). There have also been a few changes to the Flash Gallery style 
panels, but these are really not much different from the HTML gallery 
style.

Site Info panel

The Labels panel is now renamed the Site Info panel (see Figure 5.9). 
Use this to enter custom site information. Site Info now incorporates 
the Identity Plate section, which used to be located in the Appearance 
panel.

Appearance panel

The Appearance panel shown in Figure 5.11 includes a new option to 
Add Drop Shadows to Photos. You can also uncheck the Section 
Borders option if you want to remove the dotted line that separates 
the site title and the Collection title at the top and bottom of the web 
gallery pages.

To show you how these will affect the web gallery pages, Figure 5.10 
shows an example of a gallery page where Add Drop Shadow to Photos 
and Section Borders have both been checked. If you click on the swatch 
color next to it you can choose a new color for the section divider lines 
(see the Colors palette in Figure 5.12).

Figure 5.8 The Template Browser 
panel

Figure 5.9 The Site Info panel

page references
template Browser panel  303 

labels panel   285 
appearance panel                288–292
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The Image Pages section is brought over from the Output Settings 
panel. You used to be able to set the image page pixel dimensions in 
the Output Settings. But now you can do this via the Appearance panel 
instead. Plus you can switch the Photo Borders on or off and define the 
border color of your choice.

Figure 5.10 This view shows a preview of an HTML gallery page showing a gallery 
photo with a border and drop shadow added. 

Figure 5.11 The Appearance panel.

Figure 5.12 Clicking on the Section 
Borders or Photo Borders swatches 
in the Web module opens the Colors 
palette shown here.
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Image Info/Output Settings/Upload Settings

The Image Settings panel is now renamed the Image Info panel, 
which is shown here in Figure 5.13. The functionality remains exactly 
the same: you use these options to add metadata information such as 
the filename to the page views.

As I just mentioned, the Output Settings is still there, but minus the 
page size control (which has been moved to the Appearance panel). 
There is also an option to include the Copyright Only information 
or include All the metadata information in the gallery JPEG images. 
Including all the metadata information embeds details like the IPTC 
and keywords metadata in the web gallery JPEG images. Choose this 
option if you want to include such metadata, but be aware that this 
increases the file size of the individual gallery images. If ‘Copyright 
Only’ is selected, that information is all that’s is embedded, which 
keeps the gallery JPEGs lightweight in size.

The Output panel has been renamed the Upload Settings panel. No 
changes here either apart from the new name.

Removing modules
Advanced Lightroom users will be aware that it is possible to hack into 
the program contents, remove modules from the Lightroom program 
and for the program to then launch and run as normal, minus the 
module you just removed. With version 1.0 there were some overlap 
issues that were not completely resolved by the effect this would have 
on other modules and the menu items in those modules.

For example, if you remove the Slideshow module from Lightroom 1.1, 
the Impromptu Slideshow menu will be disabled in the Window menu 
for the other Lightroom modules. And if you remove the Export mod-
ule, the Export menu commands will be omitted from the File menu. 
For full instructions on how to remove the Lightroom modules, refer to 
pages 314–315 in the Adobe Photoshop Lightroom 1.0 book.

Figure 5.13 The Image Info, Output 
Settings and Upload Settings panels.

page references
image settings panel    294–297 

output settings panel    292–293 

output panel   298–301 

removing modules                 314–315
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